Introduction
Support, Distribution:

VERBI Software. Consult. Sozialforschung. GmbH
http://www.maxqda.com

We thank ResearchTalk Inc. for providing a data set used in this manual/introduction.

MAXQDA and MAXDictio are registered trademarks of VERBI Software. Consult. Sozialforschung. GmbH, Berlin/Germany; SPSS, Windows, Word, Excel are registered trademarks. All other trademarks are the property of their respective owners, and may be registered in the United States and/or other jurisdictions.

All rights reserved.
Table of contents

1 First steps in MAXQDA .................................................................................................................. 5
2 The Desktop and windows in MAXQDA ....................................................................................... 8
3 Import and organization of documents ...................................................................................... 10
   3.1 Simple document import ........................................................................................................ 10
   3.2 Opening a document for editing ........................................................................................... 12
   3.3 Working with PDFs ................................................................................................................ 13
   3.4 Organizing documents in document groups and sets .............................................................. 14
   3.5 Transcribing/writing text directly in MAXQDA ..................................................................... 16
   3.6 Inserting from the clipboard .................................................................................................. 17
   3.7 The options menu .................................................................................................................. 17
   3.8 Importing structured documents ............................................................................................ 19
4 Coding ........................................................................................................................................ 22
   4.1 Codes and coded segments .................................................................................................... 22
   4.2 Creating codes ....................................................................................................................... 22
   4.3 Coding text ........................................................................................................................... 24
   4.4 Picture coding ....................................................................................................................... 28
   4.5 Organizing the code system .................................................................................................. 29
   4.6 Coding with Weight Scores .................................................................................................. 30
   4.7 Visualization of Code Segments ............................................................................................ 30
   4.8 Undoing Coding Actions ........................................................................................................ 32
5 Retrieving coded segments ....................................................................................................... 33
   5.1 Activating documents ............................................................................................................ 33
   5.2 Activating Codes ................................................................................................................... 33
   5.3 The “Retrieved Segments” window ......................................................................................... 34
   5.4 Retrieval using the weight filter ............................................................................................. 35
   5.5 Export of the coded segments ............................................................................................... 36
6 Complex text retrieval ............................................................................................................. 37
7 The search function and automatic coding .............................................................................. 41
   7.1 The search menu .................................................................................................................... 41
   7.2 The search result window ........................................................................................................ 42
   7.3 Exporting the search result ..................................................................................................... 43
   7.4 Automatic coding .................................................................................................................. 43
   7.5 The Context Searches in the Four Main Windows ................................................................. 43
8 Memos: managing your ideas ..................................................................................................... 45
   8.1 Memos in the Document System ............................................................................................ 45
   8.2 Code memos .......................................................................................................................... 46
   8.3 Memos direct at the document ............................................................................................... 47
   8.4 Linking codes with memos .................................................................................................... 47
   8.5 Free memos ........................................................................................................................... 48
   8.6 Memo Manager ..................................................................................................................... 48
9 Links: linking your documents .................................................................................................. 51
   9.1 Linking text segments and images ......................................................................................... 51
   9.2 Links to external documents and websites ............................................................................. 52
   9.3 Geolinks ................................................................................................................................ 53
   9.4 Overview of links .................................................................................................................... 53
10 Case variables and Activate by document variables .............................................................. 54
   10.1 The list of document variables ............................................................................................. 54
   10.2 Creating variables ................................................................................................................ 54
   10.3 Entering data 55
   10.4 Importing and exporting variables ....................................................................................... 57
   10.5 Statistics and Graphics ......................................................................................................... 57
11 Working with overview tables ........................................................................... 60

12 Visual tools ........................................................................................................ 62
  12.1 Code Matrix Browser ..................................................................................... 62
  12.2 Code Relations Browser ................................................................................ 64
  12.3 Document Portrait ......................................................................................... 66
  12.4 Codeline ........................................................................................................ 67
  12.5 Document Comparison Chart ....................................................................... 68

13 The Summary Grid .............................................................................................. 70
  13.1 The Idea Behind the Summary Grid ............................................................. 70
  13.2 Creating and Editing Summaries ................................................................. 70
  13.3 Grid Tables .................................................................................................... 71

14 Mixed Methods Functions .................................................................................. 74
  14.1 Activate by document variables ................................................................... 74
  14.2 Crosstabs ....................................................................................................... 75
  14.3 The Quote Matrix ......................................................................................... 78
  14.4 Typology Table ............................................................................................. 78

15 Teamwork ........................................................................................................... 80
  15.1 Styles of teamwork ....................................................................................... 80
  15.2 Alternately working on the same project ..................................................... 80
  15.3 Exchanging and comparing coded segments, memos, and variables .......... 80
  15.4 Merging of projects ..................................................................................... 81

16 Audio/Visual files ............................................................................................... 82
  16.1 Inserting Audio and Video Files .................................................................. 82
  16.2 The “Media player” Toolbar ......................................................................... 83
  16.3 Transcribing Multimedia Files in MAXQDA ................................................ 84
  16.4 Importing Transcripts with Timestamps ...................................................... 88
  16.5 Importing f4 Transcripts with Timestamps (Option B) .................................. 89
  16.6 Transcribing Directly in MAXQDA (Option C) ............................................ 90
  16.7 Synchronizing Transcribed Text with Audio/Video files ......................... 91
  16.8 The List of Timestamps .............................................................................. 92

17 MAXMaps .......................................................................................................... 93

18 Special Functions ............................................................................................... 95
  18.1 Logbook ....................................................................................................... 95
  18.2 User Management ......................................................................................... 95
  18.3 MAXApp for iPad and iPhone ..................................................................... 96
  18.4 Intercoder Agreement ................................................................................... 97
  18.5 Importing from Endnote, Citavi etc. (RIS-Format) .................................... 98
  18.6 Smart Publisher .......................................................................................... 98

19 MAXDictio (Add-On) ......................................................................................... 100

20 Important Keyboard Shortcuts .......................................................................... 105
1 First steps in MAXQDA

Welcome to the MAXQDA Introduction!

This text is intended to enable a successful entry into the program, explain its structure and functions, and provide suggestions for working effectively.

To get the most out of this introduction, it is recommended that you carry out the steps on your own computer with your own project data or with the provided.

As with all Windows programs you can start MAXQDA by double-clicking on the program icon. A MAXQDA 11 screen will appear briefly, followed by this welcome message:

Quick entry into MAXQDA: Tutorials, Help, and Example Projects

You can now call up the online tutorials, watch video tutorials, call up the introductory manual in PDF format, or launch MAXQDA Help. When you click Next, MAXQDA will ask if you want to create a new project or open an existing project.

The MAXQDA startup and login window
You have the option **Create and open new project** or **Open existing project** (A project is the basic unit in MAXQDA just like a DOC/X file represents the work unit in word.)

You can enter your user name in the empty field of the dialog box. If you are working on a project with multiple persons it is useful to credit the user in order to document who wrote a certain memo or created certain codes. The different registered users will be saved by MAXQDA, accessible through a list at the top of the window.

You can now select that you would like to create and open a new project and confirm by clicking **OK**. A windows file browser window will appear wherein you can enter a file name (e.g. “test project”) and choose the folder where you would like to save the project.

From the moment you start the program, MAXQDA will save every single step automatically, so you do not need to regularly save your work, as you might do in other programs like Microsoft Word. It is still **strongly** recommended, however, that you secure your project from time to time with the **Backup project** function in the **Project** menu. It makes sense to keep the project name and add the given date (e.g. “test project 02-21-11”). This way you are always able to access earlier stages of your project.

Additional MAXQDA projects can be created by selecting **Project > New project** in the taskbar. You can create an infinite number of projects.

A project consists of text groups, texts, codes, coded segments, memos, variables, text links, etc. Technically speaking, a project is administered as a single file (file extension MX5).

---

**All files in your project are saved in a single file.** Project files are easy to trace with the MX5 extension. All relevant documents can be secured by doing a simple backup of the project file!

The only exceptions to this rule are (1) image and PDF files that are larger than the set maximum file size (set under **Options** in the **Project** drop-down menu), and (2) multimedia files. These files are then stored in the folder designated for external project files.

---

**Opening a project last used in an older version of MAXQDA**

When opening a project in MAXQDA11, it will automatically display only MX5 files. To open projects that were saved in an older version of MAXQDA, you need to change the type of file it is searching for. To do so, simply click on the arrow next to **Files of type**, and select the appropriate option.
First steps in MAXQDA

Opening an existing MAXQDA project
2 The Desktop and Windows in MAXQDA

As soon as you have clicked **Save** in the Windows file dialog, MAXQDA will open the new project “test project” which, of course, holds no data. At the same time the “Tips and tricks” window will appear and give you a useful piece of information about the program. If you do not wish to receive these tips, simply unclick the box in the bottom left hand corner.

After closing the “Tips and tricks” window, you will notice that the user interface is constructed just like the Windows programs you are used to. Similar to the Microsoft Office programs, the file name of the current project can be found in the title bar.

Beneath the menu bar is the “MAXQDA standard” toolbar allowing quick access to the frequently-used program functions. To the right of the toolbar you will find the “Code” toolbar, offering different functions for coding and editing the current text. Additional toolbars can be activated by clicking on the **Toolbars** drop-down menu. All activated toolbars can be dragged and moved.

The toolbars “MAXQDA standard” and “Code” underneath the menu

Underneath the toolbar you will recognize the four main windows of MAXQDA.

The four main windows of MAXQDA

The four main windows provide the following features:

- The “Document System” displays all imported texts, images, and multimedia files in your project. All your material is collected here and can be sorted into multiple texts.
- The “Code System” consists of the category system with the created codes and subcodes, as well as the number of administered code segments
- In the “Document Browser,” one document from the “Document System” appears and can be edited, which means that you can mark text segments, attach codes, or create memos. Georeferences are also visualized in the Document Browser.
- The “Retrieved Segments” window allows you to look at a selection of coded segments that correspond to the activated documents and codes.
All windows grant you direct access to the management functions: simply right-click on the icon or directly into the blank sections. Beneath the menu bar is a bar with quick buttons, which allow you to access to frequently-used program functions.

While working, all four windows can be displayed or hidden via these icons or via the Windows menu. You can customize the screen to suit your needs using the Screen Layout Manager.

The Screen Layout Manager

The three-column layout is appropriate for widescreens. For other screen formats, you can switch to one of the other layout options, including the traditional layout from earlier versions of MAXQDA, from the Screen Layout Manager. The four windows can be repositioned from right to left, regardless of the layout you choose.
3 Import and organization of documents

MAXQDA makes it easy for you to import and organized various types of documents, including text documents (DOC/X, RTF, TXT), PDF files, and images (JPG, GIF). These texts can contain all sorts of objects, such as tables, pictures, graphics, etc. Text and images can also be pasted into documents already imported via the Windows clipboard.

The way to work with audio and video files in MAXQDA is described in chapter 16 Audio/Visual files.

3.1 Simple document import

With MAXQDA you can enter new texts, copy texts via the windows clipboard, or import documents as a file. In most cases you will want to import an existing text file. These files can contain all sorts of objects, e.g. charts, pictures, graphics, etc.

**Attention:** When importing a text file into MAXQDA make sure that it is not open in another program (e.g. in Word)!

**Import via drag-and-drop**

Importing documents in MAXQDA is intuitive and easy: simply drag as many files as you like from Windows Explorer and drop them into the “Document System” window. It is useful to define different document groups in order to better organize your data. This can be done by right-clicking the “Document” root in the “Document System,” and selecting “New document group” from the context menu.

![The main window of the “Document System”](image)

**Import via pop-up menu**

You can also right-click on the **Documents** icon in the “Document System” window and select **Import document(s)** from the pop-up menu. The following file dialog allows you to select the text of your choice – strikingly similar to opening a file in Word.
Documents can be imported by right-clicking on Documents and after that Import document(s)

Import via menu “Documents”

Files can also be imported via MAXQDA’s main menu. Select Documents>Import Document(s), or use the keyboard shortcut Ctrl+Shift+T.

Visualization of documents

In MAXQDA it is possible to import graphics and image files into the “Document System” and organize them as you would text documents. Importing these image files is done just like you would import text documents. The documents shown in the “Document System” are visualized with various symbols depending on the type of file. RTF and DOC/X files are visualized with the symbol, PDFs are visualized with the symbol, and pictures have the symbol.

By moving the mouse onto the name of a document you will see a tooltip, which gives you information about the size of the document, the author (the user that imported the text), the date of the import, the number of coded segments, and the number of memos.
3.2 Opening a document for editing

In order to look at or edit a document, it has to be loaded into the “Document Browser” window first. There are two possibilities to do so:

- Either double-click the name of the document in the “Document System” window,
- or right-click the name of the document and select the option Open document from the context menu.

Texts can be opened by right-clicking and choosing “Open document”

The opened document will be signified by a specific symbol (horizontal pen) in the “Document System” window.

Opened text signified by a horizontal pen: “Teresa”

After opening the text, you will see it in the “Document Browser” window. Appearing in the title bar behind the word “Document Browser” will be the name of the text group and the current text. Immediately in front of the text will be a column with the paragraph numbering.

Opened text in the “Document Browser”

Documents arrange themselves into a certain number of paragraphs. A paragraph equals a paragraph in Word, meaning that every paragraph ends by pressing return. In other words, a paragraph represents the text in between two paragraph breaks.

In front of the paragraph numbering column you will see a light-greyish column that is, for now, empty. Later on this column will show the text memos. There is another empty, grey column that will later show your code segments. This column can also be moved to the other side of the text by dragging it with the left mouse button.
Opening texts in tabs

In MAXQDA it is now possible to open multiple texts in the “Document Browser.” Instead of double-clicking on a text, right-click and select **Open document in a new tab**. Rather than replacing the document that was formerly opened in the “Document Browser,” both documents will be in the window. You can toggle between the texts by clicking on the appropriate tab.

![Two opened tabs in the “Document Browser”](image)

In the example above, two different documents are open, and “Joanna” is currently being displayed. Switch to the other tabs by simply clicking on the name.

You can also open an entire document group or set in tabs by dragging the group or set onto the “Document Browser” window.

Using tabs is especially helpful if you need to constantly switch back and forth between several documents or if you have extremely large documents that take a while to load.

### 3.3 Working with PDFs

In MAXQDA it is possible to import PDFs directly into your project just like you would with DOC/X or RTF files.

![Opened PDF file in MAXQDA](image)

There are, however, several differences in how you can work with the PDFs:

- The basic separation units with PDFs are pages instead of paragraphs.
Organizing documents in document groups and sets

- PDFs cannot be edited in the “Document Browser.” Entering Edit Mode as you would do when working with RTF or DOC/X files is not possible.

- Some PDF files are simple “pictures” or scans of text. Text in this type of PDFs can only be coded as you would code images.

Coding text within a PDF is very similar to doing so in any other text document; You can code as little as a single character or as much as an entire page. PDF files, however, are broken up into units by page instead of by paragraph. Because the PDFs can’t be split up into paragraphs, it is not possible for MAXQDA to differentiate between paragraphs on the same page.

You will also notice that PDFs are not viewed as the other text files. When you double-click on a PDF in the “Document System,” the first page will appear in the “Document Browser.”

To move between pages, however, you will need to activate the **Document navigation** from the **Toolbars** drop-down menu. It looks like this: 

The first four symbols are for navigating between pages.

- takes you to the first page,
- moves you up one page,
- moves you down one page, and
- moves you to the very last page.

You can also zoom in and out, view the document in its original size, change the view so that it fits the window horizontally, or fit the entire document into the window.

- toggles “Continuous View” on and off for PDF files.
- shows all bookmarks within a PDF document for quick navigation.

**Tip 1:** The zoom in and out functions in the “Document navigation” toolbar can also be used to zoom in and out of “normal” non-PDF documents.

**Tip 2:** If you are using a mouse with a wheel, you can hold the Alt key and use the wheel to jump between pages of a PDF.

**Tip 3:** You can also zoom in and out with the mouse wheel by holding the Ctrl key.

3.4 Organizing documents in document groups and sets

In principle, document groups function like folders in Windows Explorer. To create a new document group, right-click **Documents** in the “Document System” window and select **New document group**. MAXQDA will always suggest a name: Group 1, Group 2, Group 3, etc. You can accept this suggestion or, even better, choose a more meaningful name.

It is possible to rename your document groups at any time by right-clicking on an existing text group and selecting the option **Rename document group**. There is no restriction on the number of document groups in MAXQDA.

In the aforementioned step you created a document group; now you will be able to insert documents into this group. To do this, right-click the concerned document group and select the command **Import document(s)** from the menu. You will find some sample texts in the following program folders:
Windows XP: My Computer > Shared Documents > MAXQDA11_Examples
Windows Vista: Desktop > Public > Public Documents > MAXQDA11_Examples
Windows 7: Libraries > Documents > MAXQDA11_Examples
Windows 8: C > Benutzer > Public > Public Documents > MAXQDA11_Examples

Imported documents in the “Document System”

After importing, you can open each document by simply double-clicking on it. The document will now be available in the “Document Browser.” RTF and DOC/X files can be edited in MAXQDA by opening the concerned text and pressing the Edit Mode on/off symbol in the “Code” toolbar. Then you can change, edit, or add to your text.

MAXQDA makes it possible for you to create “document sets,” which act as temporary groupings of documents from various document groups. A set is only made up of links to the documents and does not actually cause documents to be duplicated. To create a new set, right-click on the Sets icon in the “Code System” and select New set.

Tip: If documents are activated when you choose to create a new set, these activated documents will automatically be added to the set.

You can then give the new set a name (e.g. married male interviewees). Any set can be edited or added to by dragging new documents into it or right-clicking on a document already in the set and choosing to delete it from the set. Sets remain available to you until you choose to delete them by right-clicking on them and selecting Remove set.
3.5 Transcribing/writing text directly in MAXQDA

It is also possible to create a new text in MAXQDA, either by writing or transcribing (see free transcription tool f4 online) directly into the “Document Browser” or via copy and paste from a different source (internet, Word, Wordstat, Excel, etc.).

In order to enter new text, an empty text has to be inserted into the “Document System” first. Right-click on the document group of your choice (or the root of the “Document System”) and select the option Create document. After clicking OK in the next dialogue MAXQDA creates a new text with the name “Text n” (“n” represents a continuous number in the “Document System”). In MAXQDA there are two modes available for text editing:

- **Code Mode** allows you to attach codes to selected text passages, and to write memos and attach them to text lines.

- **Edit Mode** allows you to edit the text, add or delete text, correct mistakes, and mark text passages.

The Code Mode is active by default when a text is opened in the “Document System.” Click the Edit Mode button to switch to Edit Mode. When working in Edit Mode you will see familiar features that are also found in most word processors: you can choose the font type, size, and color, as well as formatting characteristics such as bold, italics, or underline.

Open the inserted, empty text via double-click and press the Edit Mode button. You can now start entering your text.

When you switch back to Code Mode, the modified text will be saved automatically. The same happens when another text is opened in the “Document System.” You can tell if you are in Code or Edit Mode by looking at the window bar: the Code Mode shows you a quick list of the last used codes.

![Toolbar “Code” in Code Mode](image)

**Toolbar “Code” in Code Mode**

Edit Mode gives you a list of the available fonts.

![Toolbar “Code” in Edit Mode](image)

**Toolbar “Code” in Edit Mode**

While editing your text in Edit Mode you can nullify your changes with the Undo text changes or the Undo all text changes function; however, this is only possible as long as you remain in the Edit Mode. As soon as you leave Edit Mode, MAXQDA will save the edited text.

![Changes in the Edit Mode are only possible if this mode is activated](image)

**Changes in the Edit Mode are only possible if this mode is activated**

It is recommended that you do not code in Edit Mode but rather use it exclusively for the editing of texts and change back to Code Mode when you are done.

**Tip 1:** If you would like to transcribe a digital interview, see chapter 16: Audio/Visual files.
Tip 2: A new text can be created with the shortcut Ctrl+T. This shortcut creates a new text at the top position of the “Document System” and simultaneously opens it in the “Document Browser,” enabling the Edit Mode, so that you can immediately start writing or importing. You can also move this newly-created text to any place in your “Document System.”

3.6 Inserting from the clipboard

Text passages from Powerpoint, Internet Explorer, and many other programs can be inserted into MAXQDA via the clipboard (copy and paste) as well as with drag and drop.

In order to do so it is necessary to open a text (empty or existing text) into which you would like to import the passage and go into Edit Mode. Now select the text segment or the object (e.g. audio file in Windows Explorer or text from the internet) and copy it into the clipboard by pressing Ctrl+C. It is now possible for you to import the text into the “Document Browser” window of MAXQDA by pressing Ctrl+V.

An even easier alternative is drag and drop: simply select the segment of your choice and drag it into the MAXQDA window.

Remember that importing audio and video files can significantly increase the size of your project file. Consider the possibility of using external links. They can easily be integrated into existing texts. Mark the location where the link is supposed to be inserted (e.g. a word), right-click and select the option Insert external link from the context menu. Now you just have to select the concerned file from the Windows file dialog box.

Tip 1: To import internet pages with images, copy them to Word first and save them there or select the text segments of your choice and copy them to the clipboard. Now, as usual, you can import the text into MAXQDA or paste it from the clipboard. Due to the fact that a lot of web pages consist of very large and complicated tables, many programs fail to give an adequate image of them after importing. This is also true for MAXQDA.

Tip 2: A better option for importing a web page with images is by using an online tool or browser plugin to convert the page into a PDF file, then importing it into MAXQDA. Many tools are available for this purpose, for examples www.nitropdf.com.

3.7 The options menu

You will find some important general options for MAXQDA under Options in the drop-down menu Project.
The settings available in the Options menu are basic settings that affect the way you work with MAXQDA. Each of these settings is described in the MAXQDA manual, but the following options are worth describing here, as they are relevant for working with documents.

**Confirm deletions**: This option allows you to set whether or not MAXQDA will require you to confirm any action removing an object from your project. It makes sense to leave this box checked, since deletions cannot be undone in MAXQDA. Your only option would be to revert to a backup of your project that was made before the deletion.

**Import objects in texts (e.g. images and OLE objects)**: Checking this box causes visual objects embedded in text documents in RTF or DOC/X format to be imported with the documents. Be aware that some imbedded graphics are very large and can very quickly blow up the size of your MAXQDA project file!

**Backup externals**: Here you can set the standard folder where externally-linked files are to be kept and called up from. If you are working in a team or are running MAXQDA from a portable flash drive that is used on various computers, this option lets you ensure that the same path is set for the folder wherever you run the program.

**Do not embed if larger than [MB]**: Here you can set the maximum size for PDF and image files that are to be imported into your project file. Files that are larger than this size are put in the standard folder for external files. This option helps you avoid letting your project file get too large and unmanageable.

**Tip**: Audio and video files are always saved as external files rather than imported into the project file.
3.8 Importing structured documents

Overview

The preprocessor enables you to insert larger texts standardized and already pre-coded. If you have an interview, an online survey, or the contents of a discussion forum, you may quickly supply the text material with control characters and thereby create individual codes, codings, and documents immediately when inserting the material into MAXQDA.

Example: An online survey contained two questions and 100 subjects filled out the survey. One RTF file was created from all the entries which had been equipped with control characters. After the import of this single RTF file, all 100 texts are in MAXQDA (one text for every subject, e.g. with names ID1-ID100) and, for example, 2 code words “Answer to Question 1” and “Answer to Question 2.” All texts have already been coded according to these two code words.

Importing texts in a structured way

In MAXQDA one usually creates a text group and then inserts the desired number of RTF texts. With the preprocessor it is possible to insert any given number of texts in just one RTF file and MAXQDA will automatically recognize where to separate the texts. For the preprocessor in MAXQDA to recognize within a text where a new text begins the text has to be completed with the respective control characters.

The following syntax has to be used:

#TEXTTextname

describes the beginning and the name of a text. Until the beginning of the next text syntax the entire content of an RTF file will be assigned to an independent text in MAXQDA. The following text as a content of an RTF file would produce three texts in MAXQDA which would be named Person A, Person B, and Person C.

#TEXTPersonA
My birthplace is south of New York. I moved later.

#TEXTPersonB
I am from the Black forest and I am also going to stay there for a long time.

#TEXTPersonC
I am from a small town near Chicago. Not much larger than 200 people. It’s about time I moved.

Make sure, that there are no blank spaces in between # and TEXT, as well as in between TEXT and Textname, and capitalize the key word TEXT. Save the file in RTF format. Close Word.

Tip: You can simplify this procedure considerably if you enter, for instance, > instead of #TEXT. For the text name it could be meaningful to insert a placeholder character first. After completing the entry you may substitute the placeholders with the key words (so, e.g., > with #TEXT) with the help of the Searching and Replacing function in Word.

In order to import this text into MAXQDA follow these instructions:

1. Create a document group (or use an existing one)
2. Right-click on the text group and select Import structured document (Preprocessor).
3. Enter the save location of your file and confirm by pressing OK.
Importing pre-coded texts

Aside from the common import and separation into different texts, it is also possible to have the contents of a file directly coded when importing. This makes sense when your texts have a contextual structure that can be turned into codes in a meaningful way. For this the entry syntax has to look as followed:

```
#CODECodename
the content is placed here
#ENDCODE
```

**Important:** No blank spaces between the # sign and the word CODE, as well as between CODE and CODENAME; also make sure to capitalize the keywords (CODE, ENDCODE). It is also mandatory that you put a line break behind #CODECodename and #ENDCODE.

**Tip:** The entry procedure can be simplified by using the Search and Replace Word function.

The example given above could, meaningfully extended, look like this:

```
#TEXTPersonA
#CODEOrigin
My birthplace is south of New York.
#ENDCODE
I moved later.

#TEXTPersonB
#CODEOrigin
I am from the Black forest
#ENDCODE
and I am also going to stay there for a long time.

#TEXTPersonC
#CODEOrigin
I am from a small town near Chicago. Not much larger than 200 people.
#ENDCODE
It's about time I moved.
#ENDTExT
```

When importing the lines as an .rtf file MAXQDA creates three texts (Person A, Person B, Person C), a code (Origin) and has already assigned the given passages to this code.

**Practice example**

About 30 participants worked together in an online seminar for 3 months and exchanged information through a discussion board. In order to better analyze the discourse which took place in the forum, the text is supposed to be imported into MAXQDA. If one were to proceed via copy and paste from the website and then manually code the material, it would take days, if not weeks. In this case you may also enter data from the database by adding a pre-processor control character, copying the result to Word, and then inserting it into MAXQDA. In this way it was possible, in just a couple of minutes, to import over 500 DIN A4 pages of forum entries into MAXQDA, separated by threads and pre-coded for authors; all ready for the analysis (incl. selective programming from database).

**Importing from tables**

The easiest way to import structured texts is with Excel. Let’s say we did a survey of six people. We want to import the answers into MAXQDA, so that document groups, document names, and codes are all created at one time.

We would first create an Excel table like the one below:
## Import and organization of documents

### Example spreadsheet

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>textgroup</td>
<td>textname</td>
<td>Reason for emigration?</td>
<td>Return planned?</td>
</tr>
<tr>
<td>2</td>
<td>men</td>
<td>Carl</td>
<td>I have no perspective</td>
<td>in No, I like it here.</td>
</tr>
<tr>
<td>3</td>
<td>men</td>
<td>George</td>
<td>My employer offered me</td>
<td>don't think, because</td>
</tr>
<tr>
<td>4</td>
<td>men</td>
<td>Frank</td>
<td>You earn more money if</td>
<td>Yes, I miss my friends,</td>
</tr>
<tr>
<td>5</td>
<td>women</td>
<td>Liz</td>
<td>I feel better in southern</td>
<td>This depends on my children</td>
</tr>
<tr>
<td>6</td>
<td>women</td>
<td>Ann</td>
<td>Private circumstances</td>
<td>I can't imagine that.</td>
</tr>
<tr>
<td>7</td>
<td>women</td>
<td>Maria</td>
<td>My husband has relatives</td>
<td>Yes, we want to go back</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>medical assistant</td>
</tr>
</tbody>
</table>

For the this example, the first line must always contain the keywords “textgroup,” “textname,” and the code names. The first two columns contain the name of the text group and the name of the text as they should appear in MAXQDA. The headings of the following columns contain the name of the codes that have to be applied to the text segments of the particular column. Each row contains the appropriate corresponding text.

**Tip:** The green color in the column headers is just there to make the visualization as clear as possible; this does not, however, have any effect on the import into MAXQDA.

To import this table into MAXQDA, we would right-click on the Documents icon in the “Document Browser” and select Import documents from spreadsheet, or we could find the same option in the Documents drop-down menu.

You will then see a window wherein you can select the XLS/X document that you just created in MAXQDA. You will then be asked whether empty cells should be ignored or not. Choose Yes.

Finally, the text segments will be imported and coded according to their position in the table:

All of the documents listed in the “textname” column in the Excel spreadsheet are now listed in the Document System, sorted according to the document groups you assigned in the “textgroup” column.

The rest of your column headers have been inserted as new codes and can be seen in the Code System.
4 Coding

4.1 Codes and coded segments

One of the main functions of MAXQDA is the assignment of a code to text. A code is a string of up to 64 characters, which is assigned to selected segments of text. Codes can be ordered into a hierarchical structure in the “Code System” window. When just starting a project this window is empty except for the Code System and Sets icons. On top of the code system, you’ll see a toolbar that gives you quick access to functions often used.

A code is, in the language of empirical sociological research, a contextual category, which serves as an analytical tool for the systematic analysis of data. MAXQDA allows the definition of a hierarchical code system with up to ten levels. The number of codes is not restricted. A color can be assigned to each code and subcode.

The development of codes is user-controlled and is not automatically conducted by MAXQDA. The process of assigning text passages (or object) to one or several codes is called coding. Text passages assigned to a single code are called coded segments. You can always have MAXQDA show and list specific coded segments via text retrieval.

4.2 Creating codes

The “Code System” is shown as a tree structure on the screen. It looks like the file folder in Windows Explorer you are familiar with. A plus or minus sign in front of the code name indicated that a code contains subcodes. You can expand the subcategories or close them by clicking this button.

Defining a code is like opening a drawer in which you can put any number of text segments. The drawer’s label, i.e. the code name, can later be changed without affecting the contents of the drawer. You can also print the “Code System” or export it.

To create a new code in the “Code System” on the highest level you can

- either click on the icon in the toolbar,
- use the shortcut ALT+N,
- or right-click on the and choose New code.

The following dialog box allows you to enter the name of the new code, assign it a color, and write a code memo.
Newly defined codes are always put at the beginning of the list (at the appropriate level, of course).

The “Code System” after inserting new codes

Defining subcodes

To define a subcode, simply click on the next higher code. You can then use any of the options mentioned above: either click on the symbol in the toolbar, press ALT+N, or select the option from the context menu.

In this way, we now want to setup the following three subcodes for the code “placement program”:

- preferred placement
- worst case scenario
- actual placement
The order of the codes and subcodes in the “Code System” can easily be changed with the drag-and-drop mouse function.

You can also sort them alphabetically by clicking the menu option Sort codes.

**Attaching colors to codes**

A code can be assigned any given color attribute. The best practice would be to do this while defining the code, but it is also possible by later right-clicking on the code and selecting the option Color. The use of colors in MAXQDA has a functional purpose; it is possible to demonstrate systematic differences between codes by means of visualization. The underlying system is freely defined by the researcher; the choice can be influenced by contextual (Topic A = blue, Topic B = yellow, etc.), methodical (phenomenological codes = red; theoretical codes = magenta), or other aspects. While analyzing focus groups it is possible, for example, to assign different colors to different speakers. When defining a subcode you have the possibility of it inheriting the color of the mother code by checking the box.

**Code memos**

Memos can be attached to codes. This can be done while defining the code, but also later by right-clicking the code of your choice and selecting the option Code Memo. Code memos serve an important function, especially for teamwork: you can enter definitions or anchor examples, which are always directly accessible. (See Chapter 8.2 Code memos).

### 4.3 Coding text

The assignment of codes to text segments in MAXQDA is called coding. The smallest segment of text which can be assigned a code is one character.

Of course, one would normally select at least one word to assign a code to. Coding is possible in different ways, but you must always first select the passage of text with the mouse. MAXQDA offers different ways to do the coding:

- **Classical coding**: select a text passage and attach an existing code from the “Code System.”
- **Free coding**: this is the typical style of initial coding in grounded theory – a new code will be attached to each text passage.
- **Targeted, selective coding**: text will be scanned for a selected code. When a text passage is found that belongs to the selected code, coding will be performed.
- **In-vivo coding**: the term in-vivo also comes from grounded theory and means that words or terms used by the interviewees are so remarkable that they should be taken as codes. In-vivo coding adds these terms of the respondents as codes and codes the text passage at the same time.
- **Color coding**: This works like highlighting a text passage in a book with a colored text marker. In MAXQDA five different colors can be used for color coding: RED, GREEN, BLUE, YELLOW or MAGENTA. The “Highlight coding” toolbar can be chosen from the Toolbars menu.
- **emoticode**: text segments will be assigned an emoticon or symbol.

#### 1. Classical coding

In order to assign a segment to a code you will have to mark the passage first:
Marked text in the “Document Browser”

It is now possible for you to assign the passage to the given code via drag and drop (by keeping the left mouse button pressed and dragging the marked passage directly onto its assigned code). This step is also reversible, meaning that you can also drag a code to a marked text segment.

A text segment can be assigned multiple codes.

Coding via drag and drop

In the “Document Browser,” coded elements will be highlighted with a colored visualization at the margin of the text. By right-clicking on the square of the visualization and selecting the command Delete, you can delete the coding again.

Code strip beside the text

The shortcut CTRL+W allows you to define and create a new code. This procedure is recommended if you, for instance, are working on a text and find a passage that you would like to code but you haven’t created a fitting code yet. Simply mark the passage, create a new code using the shortcut CTRL+W and click OK: the segment will automatically be assigned to this new code.
2.Free coding

If you are working with grounded theory and you wish to assign a code, which does not yet exist in the “Code System,” to a text passage, it is suggested that you use the shortcut CTRL+W. A dialog box will open where you can type in the name of this new code. The code will then be inserted into the “Code System.” You can later on, if you choose to, move the code within the “Code System.”

Instead of using the shortcut CTRL+W, it is also possible to open the context menu by use the right-mouse button.

3. Targeted, selective coding

This procedure is especially useful if you, usually in an advanced state of your analysis, want to target certain phenomenon’s that have already been defined as codes while working on your texts. The Quick List above the “Document Browser” can be used for this purpose:

The Quick List is included in the toolbar “Code”

Left-clicking on a code in the “Code System” results in its insertion into the Quick List. A marked text segment can be coded directly by pressing the symbol Code right next to the Quick List with the selected code.

This procedure can also be conducted by using the shortcut CTRL+Q. After marking the text segment it is also possible to open the context menu via right-click and select the appropriate option.

4. Coding with the code favorites

If you are working with a more complex Code System, it can make sense to take advantage of the Quick List and the code favorites. The code favorites option lets you select exactly which codes are to be made available in a window, which you can then apply with a single click. You can move this window wherever it is most convenient for you (e.g. right next to the Document Browser). The code favorites can be used as follows:

The code favorites are a new feature for quick coding. To add a code to the code favorites, right-click on the code in the “Code System” and Add code to code favorites:

Code favorites facilitate the coding procedure

As soon as you add the first code, the code favorites window will appear. You can then place it wherever you want it on your screen:
The code favorites window

You can then highlight a text segment in the “Document Browser” and code it with one of the codes in the code favorites by simply left-clicking on the code name. This is also extremely practical if you want to code a text segment with several of the codes.

To remove codes from the code favorites window, simply check the box next to each one that you want deleted and then click on the button.

5. In-vivo coding

The term in-vivo coding originated from grounded theory. It means that expressions and sayings from the text will be used as codes while, at the same time, the concerned text segment is coded.

In MAXQDA this happens in the following way: you mark the expression and click on the symbol Code in-vivo or use the shortcut Ctrl+I. The expression will be added to the “Code System” and the text segment will be coded. Should you choose to extend the coded segment, simply mark the text passage of your choice surrounding the in-vivo code and press the symbol Code; you could also use the shortcut Ctrl+Q. MAXQDA will now change the coded text segment according to the new segment margins.

In-vivo coding can also be done by right-clicking and then selecting Code in-vivo from the context menu.

6. Color coding

Similar to traditional analysis done without a computer, it is possible to highlight segments of text with colors (RED, GREEN, BLUE, YELLOW or MAGENTA) and code them accordingly. This procedure is recommended for an initial, raw overview of the data material: you can mark important or noteworthy passages without yet deciding why they’re important and what they should be coded as. The color-coding function is accessible by activating the “Highlight coding” toolbar in the Toolbars menu.

You can then mark the text and click on the color of your choice in the toolbar. This text segment will now automatically be highlighted that color and assigned the code RED (this code will be created automatically during the first assignment and inserted at top of the code system).

Later you can transfer the roughly-coded segments (coded RED, for example) to selected codes by using the activation function (see Chapter 5.2 Activating Codes) and choosing to only display text segments coded with RED. You can then drag and drop the retrieved segments onto the new codes. Of course you may also keep the collection RED and simply change its name.
7. emoticons

In MAXQDA 11, it is possible to assign a symbol or emoticon, to a text segment. Highlight the segment as usual, then click the emoticon symbol button (symbol appears as 🌟 for low-resolution screens). The emoticon selection window will then open, from which you can select from among numerous symbols.

The emoticon window

The most recently used symbols and emoticons will be automatically displayed in the first tab. Frequently used symbols can also be saved as emoticon favorites. To do so, right-click on the symbol and select Add to Favorites.

Each emoticon has a text name which is also used as a code name. Emoticon names can be modified.

When segments are coded with emoticons, the symbols (and not the code names) will appear on the coding stripe.

Coded segment with emoticon

4.4 Picture coding

After importing an image, you can double-click on the file in the “Document System” window in order to view it in the “Document Browser.” To code a part of the picture, simply use your cursor to create a box (click and drag), and then drag the code from the “Code System” window to the box. You can also choose to right-click on the box and select one of the coding options from the menu as shown below.
Codes can be assigned to a marked region in a picture via right-clicking

4.5 Organizing the code system

Deleting codes and coded segments

It is possible to make changes in your existing “Code System” at any time. To remove a code, simply right-click on it and choose Delete codes(s). Be aware, though, that this also deletes all subcodes!

It is also possible to delete single coded segments by right-clicking on the little square symbol in the middle of the coding strip of a coded segment and clicking Delete in the context menu that appears.

Deleting code after right-clicking on the code strip

Changing the structure of the “Code System”

You can change the structure of your code system by moving the codes. Simply drag a code with the left mouse button to the place of your choice.

Hint: Hold down the Shift-key, to place a code between two other codes.

Copying parts of the “Code System”

It is not uncommon for codes to have the same subcodes. Given, for instance, that you have two codes “Opinions” and “Behavior” and you would like to define the subcodes “Work,” “Politics,” and “Family” in each of them. MAXQDA will save you the hassle of entering the subcodes twice. First, define the three subcodes for the code
“Opinions,” then right-click on “Opinions,” and select **Copy subcodes** from the context menu; then right-click on the code “Behavior” and select the option **Paste subcodes** from the context menu. This option proves to be especially useful when working with different independent team members and wanting to have the complete category system available for all of them.

### 4.6 Coding with Weight Scores

In some cases, it is helpful to be able to assign relevance scores to coded segments. One could use these scores, for example, to indicate that the segment is an especially good example for that particular code or theme.

The weight score for coded segments in MAXQDA can be set from 0-100, and unless otherwise indicated, each coded segment receives the standard weight, which is set to 0. You can change the default weight score in two ways:

1. Change the default weight score in the “Options” menu: The options menu can be found in the “Project” drop-down menu. Here you can enter a number from 0 to 100 to be automatically assigned to all new coded segments.

2. Change the default weight score in the status bar: The status bar is located at the bottom of the screen and shows the current default weight score. Double-clicking on the symbol allows you to enter a new default weight.

   ![Changing the standard weight via the status bar](image)

   **Tip:** It makes sense to have the default weight score as 50, because you can later increase or decrease the score. If it is set to 0, the score can only be increased.

If you want to change the weight score for a single coded segment, you can right-click on the coding stripe in the “Document Browser” and choose to **Modify weight**:

![Changing the weight by right-clicking on the coding visualization](image)

You can enter the new weight score in the window that appears:

![Choosing the standard weight](image)

### 4.7 Visualization of Code Segments

The visualization of a newly-coded segment is recognizable in the coding section in front of the text. The visualization of the coded segments has the same color as was assigned to the code (default= green). Via context menu in the “Code System” window it is also possible to assign a color attribute to a code at a later time.
By moving the mouse cursor over a coding strip a box will appear, giving you information about the code, its weight, creation date, and author. Clicking on the visualization will highlight the code in the “Code System” window.

Should you choose to view only specific codes, MAXQDA offers you an array of options. By right-clicking on the grey area of the coding section a context menu will open.

You can now select to view the visualization:

- of activated codes,
- of codes by a certain user or
- of codes with a certain color attribute.

All of these options are available in combination with each other and it is also possible to blend out all visualizations. Furthermore you can blend-in or blend-out the title, as well as the author and date in the box.

The type of representation can be defined in the visualization sector of the context menu.

The selection window for the visualization will also appear if you click on the icon in the toolbar above the “Document Browser.”
4.8 Undoing Coding Actions

If you realize that you have coded sections of documents that incorrectly or simply decide you don’t want it coded any more, you can choose to do undo that coding.

The easiest way to do this is with the button next to the emoticode button:

*Button “Undo code”*

Clicking on this button opens up a list of all of the coding you have done during the current session. To undo one of them, simply click on it:

*Undoing coding*
5 Retrieving coded segments

The process of finding previously-coded segments and collecting them into a list of results is usually referred to as “retrieval.” The principal behind MAXQDA’s retrieval is simple: for each activated text, the text segments of the activated codes will be collected in the “Retrieved Segments” window.

The selection of codes and texts happens through the function of activation. Activation is a central function in MAXQDA, which allows highly selective access to your data and enables you to conduct a quick and efficient analysis even when working on very large projects and with complex searches.

5.1 Activating documents

As you already know, all your texts and text groups are displayed in the “Document System.” To activate a particular text you may choose between two alternatives:

- Right-click on the text and select Activate from the context menu, or
- hold the Ctrl-key and left-click on the text name(s).

![Image](image.png)

In this example the documents “Joanna,” “Kim,” “George” and “Vincent” are activated

You can activate all texts within a text group by holding down the Ctrl-key while clicking on the name of that text group. The names of activated texts are displayed in red, the inactivated ones in a bluish-green. Additionally, a red arrow points out activated texts.

5.2 Activating Codes

The activation of codes follows the same principle as the activation of text documents. Either you select a code using the right-mouse button and select the Activate option, or, as in working with documents, you left-click on the codes while holding the Ctrl-key.

Similar to the activation of texts in the “Document System,” the color of the codes shows when they are activated: activated codes appear red and will be pointed out by an arrow.

At the bottom of the MAXQDA window there is a status bar which lists, from the left, the total number of texts and codes that are currently active, and the number of coded segments that have been retrieved:
5.3 The “Retrieved Segments” window

All of the coded segments retrieved through the selection or activation of certain texts and codes are shown in the “Retrieved Segments” window.

To the left of each text segment you can see the name of the text and the paragraph number from which the segment originates and which code was assigned to it. If a memo was assigned to the segment this will also be displayed.

Tooltip

When you click anywhere on this box, the original text from which this segment was taken will be opened in the “Document Browser” window at the position of the coded segment. In the example above, the following information is given: the segment was taken from paragraph 12 of the text “Joanna” from the text group “New York.” It was assigned the code “Day-to-Day Issues > Emotions.”

You can also search for text segments that have been assigned more than one code. For example, you could search for the places where the respondents spoke about their “Personal Motivation” and their “Qualifications” in a group of interviews. More about this later.

A toolbar is located on top of the “Retrieved Segments” window where you have access to frequently-used functions. Here you can also switch to the “Overview of retrieved segments” by clicking the icon.
5.4 Retrieval using the weight filter

MAXQDA also lets you use the weight scores as criteria for retrievals. The only requirement is that you need to have assigned weight scores. To add this filter, select **Edit weight filter** from the “Analysis” drop-down menu. The following window will appear:

![Editing the weight filter]

You can then choose **Use weight filter** from the same drop-down menu to start applying the filter parameters you just set.
5.5 Export of the coded segments

Exporting the complete texts of the found segments to word is possible via the menu command **Project > Reports & Export > Retrieved segments**. An RTF file will be created, which you can now open with Word.

You can choose to export the coded segments as an XLS/X (Excel), RTF, or HTML file. If you only want to export the segments as they appear in the “Retrieved Segments” window, you can highlight them all with **Ctrl+A**, copy them with **Ctrl+C**, and the paste them into another document with **Ctrl+V**.

If you want to export the table overview, the fastest way is to press the **Export** icon in the table overview toolbar.

The presentation of coded segments as an HTML table is very clear and concise. This export function can be found in the “Retrieved Segments” window toolbar:

![Export the “Retrieved Segments” window](image)

MAXQDA creates an HTML file, which will automatically open your standard browser after the export. However, you may also choose to open the file directly in Excel.

**Tip:** You can deactivate all codes and texts with the Reset activations icon. You should make use of this function on a regular basis in order to prevent false results, which might come from the fact that you unintentionally activated (e.g. from an earlier search) parts of your data.
6 Complex text retrieval

The use of the **Coding Query** function enables you to search for patterns in your data and view them in the “Retrieved Segments” window. The standard option is the Or-Combination, which looks for text segments in any activated text with any of the activated codes.

The text retrieval dialog box allows you to choose from nine different combination options. You can switch back to the default analysis in which the selection of codes happens through activation and all codes are included into the text retrieval by selecting Or-Combination.

Here is an example of how you can use one of the functions:

If you want to see all coded segments that are near to another specific coding within a specific distance, you'll want to use the “Near” function.

First activate all the texts that should be included in the search. The text retrieval window can be accessed

- in the drop-down menu **Analysis > Coding Query**
- by clicking on the icon in the “MAXQDA standard” toolbar or
- by right-clicking in the grey area of the “Retrieved Segments” window and selecting **Coding Query**.

![Different possibilities to activate the Coding Query function](image-url)
The following window is then opened:

“Coding Query” window

After entering a query name, you can select from among all possible query types in the dialog window. This includes, among others, the possibility to include only activated documents and codes. The current activation status is indicated after the “activated” option in brackets. In the figure, 4 of 16 documents and a total of 9 codes are activated.

For complex queries, a further dialog window will appear in which you can select the complex query method. An example of one of the nine complex query methods is detailed below:

You want to retrieve all those coded segments, which are followed by coded segments coded with another code within a defined distance.
The complex query window

The Coding Query window allows you first to select the function for the definition of parameters. By choosing one of the functions in the Function menu, you can see a visual explanation on the right side of the window, along with a written explanation at the very bottom of the window. This will clarify which calculations the function conducts. Windows A, B, and sometimes C are important for specifying which codes are to be used for the search. For the function “Near,” one has to, for instance, specify which code has to appear in proximity of which other code and how large the maximal distance between the coded segments should be (in paragraphs).

The selection window is set up as follows:

- In the top section of the window a selection list allows you to select the desired function.
- The function will be visualized on the right side.
- The selection windows A, B, and C allow you, according to the selected function, to select the codes and the definition of parameters.

Window A refers to the activated codes, which means that if one were to place a code into this window to, for instance, determine intersections with another code, both codes have to be activated first. The two codes will then be moved into window A after clicking on the button All activated codes.

The functions Intersection and Overlapping do not require any other parameters. You simply need to enter the appropriate codes in Window A and click Execute to start the text retrieval.

The windows B and C are active for more complex functions, where specific selections are being made. Window B works with the Quick List. For example, if we are testing whether there are text segments within the activated texts where the code listed in window A is completely inside the text segment, which has been coded with the code listed in window B.
The status bar shows the chosen retrieval function.

**Tip:** If nothing is being shown in the “Retrieved Segments” window, it could be because you accidentally chose a retrieval setting other than the standard OR combination. You can check this by looking at the status bar.

Please consider this for complex text retrieval also: all functions of complex text retrieval only apply to activated texts.

The following table summarizes the different functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intersection</td>
<td>Finds text coded with all of the codes in section A. The only text retrieved is that which is coded with all of these codes.</td>
</tr>
<tr>
<td>Intersection (Set)</td>
<td>Only lists those text passages where a minimum of x codes of the codes listed in section A are present. The only text retrieved is that which is coded with these x codes.</td>
</tr>
<tr>
<td>Overlapping</td>
<td>Lists instances where codes in Window A overlap. Coded segments that overlap with each other are shown in their entirety, rather than just that section that overlaps.</td>
</tr>
<tr>
<td>Only one code</td>
<td>Only text segments containing exactly one of the codes in section A are retrieved.</td>
</tr>
<tr>
<td>Only this code</td>
<td>Similar to “Only one Code,” but only for the code selected in section B. Only lists text segments where the code in section B but none of the codes in section A is present.</td>
</tr>
<tr>
<td>If inside</td>
<td>Text segments, that are coded with the code in section A and which are completely contained within a segment coded with the code in section B, are retrieved. Alternatively, larger section B segments are retrieved. Multiple codes can be selected in section A.</td>
</tr>
<tr>
<td>If outside</td>
<td>If text segments coded with codes listed in section A are completely outside of segments coded with the code of section B, the segments are retrieved.</td>
</tr>
<tr>
<td>Followed by</td>
<td>If text segments coded with code(s) in section A are followed by text segments coded with the code in window B within a distance of x paragraphs, the segment will be retrieved.</td>
</tr>
<tr>
<td>Near</td>
<td>If the code in section A and the code in section B are within a distance of x paragraphs, then the segment will be retrieved.</td>
</tr>
</tbody>
</table>
7 The search function and automatic coding

In MAXQDA you can search for specific words, parts of words, or strings of words with the help of the Lexical search function. The search procedures refer to

- the texts,
- the memos, or
- the coded segments, that are presently in the “Retrieved Segments” window.

The search can also be limited to the activated texts/documents. You may search in individual texts, in groups of texts, or also in texts whose variables are in accordance with conditions you define.

7.1 The search menu

The search function is started by clicking on the Analysis drop-down menu and selecting Lexical search or by clicking the icon in the “MAXQDA standard” toolbar.

Afterwards you can export, explore, or even automatically assign your search results to a specific code word.

After selecting Lexical search, the following dialog box will appear:

You can enter as many search words as you like into the empty window on the left side. To do so click on New and enter a search word or the search string you are searching for. The following wildcard characters are supported:

- ? for a single character (e.g. H?nks for Hanks, Hunks or Hinks)
- * for multiple characters (e.g. H*ks for Hanks or Hawks)
- < for beginning of word (e.g. < (inter) for Interest or interesting, but not winter)
The search result window

- for end of word (e.g. (ks) > for Hanks or thanks, but not Bankside)

You can remove a search string by clicking **Delete** or change your search entries by double-clicking on them.

You have the option of searching **In documents** or **In memos**. If you enter multiple search words, you can decide how to combine them for the search function. **OR** leads to results in which at least one of the search words is contained. The option **AND** finds those text segments, which include all search words. In this case it is necessary to set the maximal distance within which the words must be to each other. (Example: List all text segments in which “fear” and “terror” appear within 2 paragraphs of each other).

Other practical possibilities are options like **Find whole words, Case-sensitive, Only in activated documents,** or **Only in retrieved segments**. These options are especially useful if you want to narrow down your search.

The search will start after you click **Run search**.

Text search procedures can be saved by clicking on **Save**, entering a name for text search procedure, and clicking **Save** again. Text search procedure files will be saved with the file extension **SEA** (the abbreviation stands for search). Saved text search procedures may be opened again at any time by choosing the button **Open**.

### 7.2 The search result window

Depending on how much text must be searched, the search process might take some time. The search results will be shown in a separate window. On the top right the number of hits will be listed. The tabular overview allows you to sort your hits by clicking on the column headers. The most important function, however, is that by clicking on a hit, the corresponding text will automatically be loaded into the “Document Browser” window in the background; the concerned text segment is already marked, which is ideal for the exploration and analysis of your findings. This way you can read through hit after hit and, if desired, code them manually.

In the toolbar, located on top of the “Search results” window, a couple of important functions are available. The icon and the icon allow you to show the results as an Excel and HTML table.
7.3 Exporting the search result

The icon allows you to export the results to an RTF, HTML or XLS/X document. The saved file will immediately be opened in the appropriate program (e.g. Word, Firefox, Excel, etc.) depending on the format you exported it in. The icon allows you to automatically code the results; and the icon allows you to change settings for the automatic coding or export.

Remember to decide before exporting, with the help of the options, if you would like to export the search string (word), the sentence, the paragraph or a certain number of paragraphs before and after the search string.

![Options for exporting hits](image)

7.4 Automatic coding

One especially handy option is to automatically code all of the places where the search string was found.

![Options for automatic coding of hits](image)

Sometimes it might make sense to code all of the text segments that were found in the search. MAXQDA can do this automatically. Simply click on the icon and select the desired code from the appearing list. Only codes from the “Quick List” will be available. If the code you want is not there, simply click on it in the “Code System” first.

Before you click on the button, you need to select what aspect exactly you want to code. You can code the search word, the sentence in which it was found, or even the entire paragraph where your search word appears. Usually it makes sense to code the paragraph in which the search word was found.

This procedure of automatic coding will most likely code unwanted hits as well. After completing the above mentioned code procedure you can easily remove these from the “Code System.” Simply activate the newly created code as well as every text involved in the search. The results will be shown in the “Retrieved Segments” window, and you can delete any unwanted codings by right-clicking on the yellow box and selecting Delete.

7.5 The Context Searches in the Four Main Windows

In MAXQDA you have the option of searching within each of the four main windows. You will find a magnifying glass icon in the toolbar of each of the four windows. You can use this search field to find text segments, document names, codes, coded segments, etc.
The search function is available in all four main windows

Context search window:

After typing in your search term, you will be able to jump back and forth between hits with the arrow buttons.

Tip: The search only works for the window in which you have called up the context search window – it does not search through the entire project.
8 Memos: managing your ideas

Memos are a classical, central instrument of qualitative text analysis and are especially significant in “Grounded Theory.” The functionality of memos in MAXQDA has been extended far beyond the known possibilities of “tacking on” information to a text. MAXQDA gives the researcher highly effective and, at the same time, user-friendly options to create memos in various ways, to always have access to them, to administer them, and also to conduct lexical searches on all of them.

Memos can be assigned to a project, a document group, a document, text segments, or a code. Like the well-known Post-It notes, memos are illustrated in yellow. They are assigned to the project as a whole rather than to a specific document, code, etc. They can always be viewed in the “Memo Manager” (see below).

8.1 Memos in the Document System

The first option for creating a memo is in the “Document System.” Here you may write a memo about your project in which you can document the process of your research, the schedules, etc.

Values like age, gender, etc. are better attached as variables, since one can later use them as limiting values in the text retrieval. You can also assign a memo to a text group or even a single text. A text memo allows you to, for example, explain the origin of your text and write down important meta information.

Right-click the concerned document and select Document memo from the context menu:

All memo entry windows in MAXQDA look identical, no matter where you want to attach the memo. There you can enter the author and a title (select a meaningful title; it will simplify finding it later!), select a fitting memo symbol (e.g.: ? for a question, ! for a definition, T, L, or M for a theoretical, literature, or methodological memo, or make up your own meanings for each symbol), and, of course, write the memo text.
When you are done with your entries, simply click on the icon to close the window. After closing the memo window, the memo will appear next to the concerned text in the “Document System” and may always be opened via double-click. You will also be presented with a content preview when holding the mouse over the memo symbol. For all the elements in the “Document System” you are only able to write one memo. The reason being that the presentation remains clear and organized and, when searching for a specific note, one does not have to look through a number of memos, thereby slowing your analysis process.

An abstract of the memo will be shown if the cursor points on its symbol.

### 8.2 Code memos

In the “Document Browser,” you can attach as many text memos directly into as many parts of an opened text as you want (e.g. to record concrete ideas or questions, literature, etc.).

In the “Code System,” you can attach one “code memo” for each code and subcode (e.g. for code definitions or anchor examples). To insert a memo right-click on a code and select the option Code memo. An existing memo will be visualized with a yellow Post-It note there, as well.
8.3 Memos direct at the document

In the “Document Browser” window, memos will be created, shown, and opened from the memo column next to the text, directly to the left of the paragraph column. If you want to attach a memo to any given text segment, right-click on the memo column at this position or right-click on the memo column next to the text and select New memo.

8.4 Linking codes with memos

Each memo can be assigned a code from the “Code System.” To do this click on the corresponding symbol in the toolbar and select the desired code from the “Quick List.” If a code is not in the “Quick List” you have to insert it by clicking on it in the “Code System.”
8.5 Free memos

MAXQDA lets you create memos that are not connected to any specific aspect of your project, but apply rather to the project as a whole. These are called “free memos.” You might use these memos for basic information about the project, research hypotheses, research goals, etc.

Creating free memos is easy – just select New free memo from the Memos drop-down menu.

These memos can be viewed or edited at any time in the Memo Manager.

8.6 Memo Manager

The Memo Manager is a table containing all memos that you have created. You can sort them according to the properties contained in the columns (name, memo type, etc.), open them by double-clicking on a memo row, edit them, if need be, or export the whole table.

If you attached a memo to a section of a document and then view it in the Memo Manager, the attached text will automatically be loaded into the “Document Browser” window and the concerned text or picture segment becomes visible.

The Memo Manager can be opened by clicking the memo icon in the “MAXQDA standard” toolbar. You can also call it up by selecting Memo Manager from the Memos drop-down menu.
Memos: managing your ideas

The “Memo Manager” gives an overview of all existing memos

By clicking on the individual column headers the list is sorted according to the various criteria. For example, you could sort by memo symbol, listing all memos with a question mark, for example, to clarify all open questions swiftly. A double-click on a line opens the memo window and lets you view the complete content of the selected memo.

Copying memos

If you’d like to re-use a memo within another text or at another text position, you can also right-click on the memo and choose Copy.

Memos can be copied and inserted at other places

Then, use the “Document Browser” to navigate to the new position, right-click the memo column and choose Paste memo. This will insert a copy of your memo which is editable without affecting the original memo.
Copied memos can be inserted via right-click on the memo column.

**Tip:** The memos can be exported by clicking the icon 📄. This function allows you to create either an RTF, an HTML, or an Excel file. MAXQDA exports all selected (highlighted) memos. If no memo is selected, all memos will be exported.

The memos can also be highlighted and then copied to Excel or other programs via the clipboard. This does not transfer the entire memo content, however, but only a preview.
9 Links: linking your documents

9.1 Linking text segments and images

In order to point out a relation between two text segments, you have the option to link them to each other. Click on one of the two linked text segments and you will reach the other one. Text links enable you to connect two text segments with each other. They have the same meaning and serve the same function as hyperlinks in the internet, namely to connect two points: an anchor and a target. As soon as one clicks on the anchor of an existing link, the corresponding target will be loaded and vice versa.

The text links in MAXQDA can link text segments either from the same text or from different texts. In order to insert a text link, the first text segment – the anchor – has to be marked in the “Document Browser.” The smallest unit you can mark is a single character, but in most cases, you will want to mark at least a phrase if not a sentence or paragraph.

After highlighting the text segment, click on the icon or right-click on the highlighted text and select Insert text link from the context menu—the text segment will now be marked blue. Now, mark the other text segment (which can also be in another text) and, again, click on the icon or select the option from the context menu. After the second text segment appears underlined, you are able to jump from one text segment to the other by clicking on either one of the text segments.

Text links are visualized blue and underlined

In order to remove an existing text link, right-click on one of the two underlined text passages and select Remove link. The other link partner will be deleted automatically.
9.2 Links to external documents and websites

It is also possible to connect a text or image segment to something outside of the MAXQDA-project – this is then referred to as an external link. Clicking on this link will then open the document or website that has been connected with that text or image segment. You could, for example, link each speaker in a transcribed group discussion to a picture of that person or to a document with additional information about that person.

To create an external link,

- highlight the text or image segments,
- right-click on it and select **Insert external link**, and
choose the file to be linked to in the window that appears.

You can also insert a link from a website:

- highlight a text or image segment as you would to insert an external link
- Select Insert web link from the context menu, and
- enter the URL, e.g. www.stern.de.

For very long URLs, follow this procedure:

**Note:** If a link was saved to the Windows clipboard, it will be automatically displayed in the input field.

### 9.3 Geolinks

Geolinks are connections between a text or image segment and a certain geographic location, allowing you to include geospatial information in your data analysis. A click on a geolink opens a program (usually Google Earth®) and takes you to that geographic location.

To insert a geolink, follow these steps:

1. Save the location in Google Earth® by clicking **Save** from the **File** drop-down menu. The location will be saved in a KML file.
2. Highlight a text or image segment in MAXQDA, right-click on it, and choose **Insert geolink**.
3. Select the KML file from the window that appears.

The existence of a geolink is shown with a green ball in the geolink column next to the text or image in MAXQDA. You can toggle this column on and off by right-clicking on the document in the “Document Browser” and choosing “Show geolink bar.”

### 9.4 Overview of links

Similar to the tabular overviews of coded segments and memos, MAXQDA offers an overview of all links in your project. Open the drop-down menu **Documents** and then select **Overview of links**. The overview lists all links with anchor and target. Clicking on a specific link will result in a jump to this text segment, which will appear in the “Document Browser.” The links overview can be exported in XLS/X, HTML, or RTF format by clicking on the appropriate icon in the toolbar.

![The “Overview of links” associated to a project](image)
10 Case variables and Activate by document variables

MAXQDA differentiates between document and code variables. More information about these two variable types can be found in the manual.

10.1 The list of document variables

MAXQDA enables the administration of variables for every text, as is common in statistics programs. You can, for example, record relevant personal data and contextual information for a text or classify specific types of text and then code the texts according to their variable values. (For example, you could add a gender and an age attribute for interview transcripts, so you could compare male interviewees of a certain age group to female interviewees of a specific age group.)

MAXQDA offers two different views: the standard variable view is called the List of document variables, found in the Variables drop-down menu. The data view can be called up by clicking on the icon in the “MAXQDA standard” toolbar or by selecting Data editor (document variables) in the Variables drop-down menu. You can switch between the two views by clicking on the icon.

You will notice in the “List of document variables” that there are already several internal variables that MAXQDA has already created for you, such as the “text size,” “group,” “author,” “creation date,” etc. You will see a total of seven of these standard variables, which will always be differentiated from the variables you create by the red square in the far left column. User-defined variables will have blue squares.

The toolbar at the top of the window includes buttons for creating new variables and switching between the two variable views.

In the “To be displayed” column, you can define which variables are displayed in the data view. When working with a lot of variables the tabular view might become somewhat confusing, so the option of displaying only selected variables can come in handy.

To create a new variable, click on the icon in the “List of document variables.” Next, enter a name for the variable, such as “Gender,” “Education,” “Marital Status,” etc. and select the variable type. Five types of variables are available:
String - for entering text (e.g. male, female, student)
Integer - for entering a whole number (e.g. 1, 7, 3940)
Floating point - for entering a number with decimal (e.g. 2.3, 453.5, 0.09)
Date/Time - for entering time or date
Boolean - creates a box, which can either be checked or left unchecked.

If you want to define the gender of each interviewee, for example, with the letters “m” and “w,” you would want to choose the variable type “string.” Keep in mind that it is not always possible to change the variable type at a later time. Numerical variables can be changed to string variables, but not vice versa.

This way you may define an (almost) infinite number of variables. The rectangular data matrix (documents * variables) can later be exported directly to statistical programs such as SPSS, SYSTAT, STATA or Excel.

10.3 Entering data

In order to enter data, you have to switch from the “List of document variables” to the “data view” by clicking the icon in the toolbar. In the data view, you will see all variables, which were marked as To be displayed in the “List of document variables” view. If you hadn’t previously been viewing the “List of document variables,” you can directly access the data view by selecting Data editor (document variables) from the Variables drop-down menu or by clicking on the icon in the toolbar.

The table in data view is similar to a data matrix found in SPSS or Excel.

Switching between the two views

Each row of the matrix corresponds to a case (document) in the “Document System.” The variables are listed in the columns. This way you can enter one value for each case (text) and each variable. All variables can easily be imported/exported to/from SPSS and Excel.

If your variable appears in the overview (you might have to scroll the list further to the right), you can assign your document a variable value by double-clicking in the corresponding cell. The entering of values into a newly created variable is easiest, when you begin with the top row: double-click into the first cell, enter the corresponding value and confirm with the Enter key. The cursor will now automatically jump into the next row and you may begin the entering of the next value.
If you want to select a value that has already been entered previously in the same column, you can click on the arrow to the right of the cell and select the appropriate value from the list. This is especially useful if the variable values to be entered are rather long, as with job descriptions, for example. The list of values can be extended at any time; new values will be adopted into the list immediately.

By clicking on the column headers you can sort the existing variables. According to the type of variable selected, the sorting will be done alphabetically, numerically, or chronologically. Repeated clicking changes the direction of sorting. Similar to the “Document System,” a document can be opened in the “Document Browser” window by double-clicking on a row in the variable window (if your variable window is maximized to full screen you need to minimize or close it to see, that the document you double-clicked was loaded to the “Document Browser.”

By right-clicking on a column header, you can access several additional functions:

The context menu can be opened by right-clicking.

The Search function allows you to search for a certain value within the list of variables, such as a certain date in the “Creation date” column.

Hint: When searching within table fields, you will only find cells beginning with your search string. In order to find any matches, start your search string with a * as wildcard character.

The Set filter function allows you to filter out the texts that do not match a certain variable. By setting the filter for “Number of Memos” to “1,” for example, you would be shown only those documents that have exactly one memo assigned to them.

Selecting the Hide option hides that particular column. In order to view this column again, simply switch back to “List of document variables” view by clicking the icon and re-check the appropriate box in the To be displayed column.

If the option List of values is activated MAXQDA presents all existing values in a column as a list while typing in a new value for a document.
The **Select fields** function calls up a window, where you have the option to choose which columns should be displayed. The internal variables are red, and the variables that you have created are black.

### 10.4 Importing and exporting variables

As in the data view, the variable view makes it possible for you to export your data in XLS/X, HTML, or RTF format in the toolbar.

It is especially helpful to be able to export the data matrix, because it can be directly imported into statistics programs like SPSS or SYSTAT for quantitative analysis. This export function is also available in the **Variables** drop-down menu by selecting **Export data matrix**.

If you want to work with this data in SPSS, it is recommended that you choose to export in XLS/X format, since it can be imported without any formatting changes.

**Attention**: If you are working with an SPSS version older than version 13, any variable names longer than 8 characters or that include spaces will be adjusted automatically by SPSS.

To import the data matrix, follow these steps:

- Export the data matrix as an Excel file.
- If necessary, add new columns with the variable names as the column headers.
- Import the data matrix by clicking on **Import data (document variable)** in the **Variables** drop-down menu.
- Choose the appropriate format for each of the variables.

Documents from other programs can be imported to MAXQDA

### 10.5 Statistics and Graphics

Using the Statistics and Graphics modules, MAXQDA can create frequency tables and their corresponding charts for variables. This function can be called up from the menu **Variables > Statistic of document variables** or from the **Statistic of document variables** button on the “MAXQDA standard” toolbar.

The split “Choose variables” window will appear, which lists all existing document variables on the left side; on the right side selected codes appear. Variables can be transferred from one window to the other using the blue arrow buttons between the windows, allowing you to select variables for analysis or remove them from the list.
Click on the column header of either list in order to alphabetize content. Once you click OK, MAXQDA begins the statistical calculation, after which the results will be displayed as frequency tables and diagrams.

**Frequency Tables**

The result window shows the table view of the first selected variables:

The first column lists the various categories of the table; the second column lists their absolute frequency; the third column, their corresponding percentages. The fourth column displays the percentages based on valid values, meaning that missing values are not taken into account. If no missing values exist in relation to the relevant variables, then the percentages will be identical in the third and fourth columns.

Click on the column headers to sort the table rows. For example, you can sort in ascending or descending order of categorical frequency.

A toolbar is displayed at the top of the results window. From here, you can:

- call up charts by clicking the Chart view button
- flip forward or back between variables
- print results, or
export results as an Excel file.

Charts

Once you have accessed the Chart view by clicking on the button, a bar chart of the selected variables appears in the place of the table.

A toolbar is displayed at the top of the window. The top toolbar is the same as that of the Frequency tables, here you can switch back to the Table view at any time. The chart can be customized using the options in the lower toolbar.

- Display labels,
- Display data values
- Display data values or percentages,
- Display legend,
- Display missing values,
- Display Y-axis scale,
- Insert a title and footer
- Change color scheme.

On the right side of the toolbar, there are three buttons with which you can switch between a Bar chart (horizontal), Bar chart (vertical) or Pie chart.

When creating charts, MAXQDA sets an initial color scheme. To customize your charts, double-click on the selected segment and choose your desired color.

All captions, titles, and footers can be modified. Double-click on a label to modify the text, right-click in order to modify the formatting i.e. font size, font and font style.

Like Frequency tables, Diagrams can be printed or exported in PNG format or as vector graphics in SVG format.
11 Working with overview tables

MAXQDA offers a number of table overviews of various aspects of your project, and these tables can be worked with a lot like an Excel file.

Let’s look at the following example, which is the case variable overview:

The “List of document variables” in MAXQDA

Each table has a toolbar at the top, which gives you quick access to the most frequently-used functions. This particular table above, for example, has a toolbar with symbols for opening the table in XLS or HTML format, for saving the file in XLS format for use in SPSS, and for switching between table views. The symbol is found in every table – clicking on it closes the window.

The column headers in the table above represent each variable, and the various font colors indicate what kind of variable each one is. Black font indicates a system variable, blue font a variable created by the user.

These system fields or project variables are always in the table:

- **Document group** – shows the name of the group in which the document is found.
- **Document name** – shows the document name.
- **Number of coded segments** – shows the number of coded segments found in that document.
- **Number of memos** – shows the number of memos found in that document.

You can always change the width of each column individually by clicking on the column separator and dragging to the right or left. Double-clicking on the separator adjusts the column to its optimal size.

You can change the order of the columns by clicking on a column header and dragging it to a different location.

If you right-click on a column header, you’ll call up a context menu. Here you have the option to hide certain columns that aren’t currently of interest to you. You can call up a list of each of the columns and only check the box next to those that you want to view.

You can very easily sort the tables according to the values of any of the columns by left-clicking on that column header.
Arranging a chart by clicking on the column header

Tables can be sorted in alphabetical or reverse-alphabetical order. The first time you click on the column, it is sorted alphabetically; the second time you click on it, it is sorted reverse-alphabetically. You can tell which order the sorting has been done in based on the direction of the arrow next to the column name.

MAXQDA tables have both editable and non-editable columns. The internal system columns, for example, can never be edited. If you want to change a document name, for example, you have to do that in the Document System, not in the variable list. The same is true if you want to change the document group for a particular document. You must drag the document from one group to another in the Document Browser. In the editable fields, you can simply double-click on a cell and type in a value.

You can also copy sections of the table to the Windows Clipboard to paste them in other programs by highlighting the selected cells and hitting Ctrl+C. You can also select the entire table with the Ctrl+A keys.

If you paste the contents of a table into Microsoft Word, they will be inserted with the cells separated by a tab.
12 Visual tools

In addition to MAXMaps, the mapping tool of MAXQDA, there are seven other visual tools, six of which you can see in the toolbar “Visual tools.” If the toolbar is not visible, simply activate it in the Toolbars drop-down menu. These tools are also all available from the Visual tools drop-down menu.

12.1 Code Matrix Browser

The Code Matrix Browser offers a visualization of the number of segments coded with each code for each document. Select the tool as described above. If you have documents or codes activated, you will be given the option of including only those activated documents and codes in the visualization. If you have too many codes or documents, the option to narrow things down is very helpful. Otherwise, select No to see all documents and codes in the visualization.

You can access the Code Matrix Browser in the Visual tools drop-down menu or by clicking on the symbol in the “Visual tools” toolbar.

![Starting the Code Matrix Browser via the drop down menu](image)

Next, a window will open which clearly presents all of the selection options for the Code Matrix Browser.

![Code Matrix Browser options](image)

You can choose whether to display the data in a simple form (i.e. single document) or aggregated form (i.e. for document groups or sets). Furthermore, you can select either documents or segments as the unit of analysis. In the first case, the frequency at which a specific code is assigned to a specific document (or document group/set) will be displayed. In the second case, the only distinction made is whether a specific code was assigned to the document or not.
**Tip:** If you only want to include activated documents and/or codes in the visualization, you will have that option when you first call up the visualization.

After making your selection, you will see the following screen:

![Code Matrix Browser: documents on the x-axis and codes on the y-axis](image)

The “Code System” is displayed on the y-axis, and the documents from the “Document System” are on the x-axis. The number of coded segments for each code in a document are represented by the squares. The color and size indicates the number of coded segments.

By moving your mouse over the square, you can see the details:

![Tooltip inside the Code Matrix Browser](image)

In the example below, you can see that the code “Day-to-Day Issues:Significantly Positive” was used to code 7 different segments in the document “Vincent.”

The toolbar at the top of the Code Matrix Browser window offers you more options for your visualization:

![Toolbar in the Code Matrix Browser](image)

- shows the Code Matrix Browser in Excel.
- allows you to export the browser as a TXT (tab delimited) or a XLS/X file.
- takes a snapshot of the Code Matrix Browser window.
- shows the coded segments represented in the Code Matrix Browser in a table.

- these three different buttons set the width of the document names on the x-axis. The first option is used in our above example. The middle option displays an abbreviated version of the document name, and the third option on the right displays the entire document name (see below).

- changes the squares to numbers, so you can see exactly how many coded segments were made in each of the documents:
uses circles instead of squares for the visualization.

simplifies the visualization by using only one size of square or circle. You can tell whether a code was used in each text, but you can’t tell how often it was used.

refreshes the visualization for those situations where you add coded segments while the Code Matrix Browser window was open.

12.2 Code Relations Browser

The Code Relations Browser creates a visualization of the intersections of codes in either a single document, a group of activated documents, or all of the documents in the “Document System.” This allows you to find connections or relationships between your codes.

As with the Code Matrix Browser, a window will appear in which you can select the settings.

Most settings have a similar meaning to those of the Code Matrix Browser (see above). You can determine whether all codes should be taken into account, or just the subset of activated codes. These settings can be selected separately for the X and Y axis. For the X axis you can also choose to display only the top-level codes. In addition, you can choose whether the intersection or proximity of codes should be the decisive criterion.
If “Near” is selected, you must determine the maximum distance (measured in paragraphs) in which the codes must appear.

As in the code matrix browser, you can check the box at the bottom of the window to select the option “Only for activated documents” in order to limit the analysis, otherwise all documents will be included.

After you have clicked OK the analysis begins, unless you have selected the option to choose top code for the columns. In this case a selection window appears where you can select the codes plotted on the X axis:

Choose the codes for the columns

After making your selection, you will see the following screen:

Code Relations Browser: number of intersections between codes

As in the Code Matrix Browser, the size and color of the squares indicate the number of instances the codes on the x-axis overlap with the codes on the y-axis.
The toolbar is almost the same as for the Code Matrix Browser (see above) except that there are two new buttons:

The icon changes the visualization to display situations where the coded segments are near each other instead of intersecting.

Click on the icon to set how close the coded segments must be to each other to be counted.

Setting the options for the “Near” function

If the maximum distance is set to two paragraphs, for example, coded segments that are within two paragraphs of each other will be counted for the visualization.

12.3 Document Portrait

The Document Portrait is a visual representation of all the coded segments in a selected document.

In order for this visualization to have meaning, it is necessary that you associate colors with codes in a manner meaningful for you, so that you can differentiate between codes based on their colors. If you were doing a psychological analysis, for example, you might have associated the code for aggression with the color red.

To open the Document Portrait,

- Right-click on a document in the “Document Browser” and choose Document Portrait from the context menu that appears, or
- click on the document in the “Document Browser” and then select Document Portrait from the Visual tools drop-down menu or click on the symbol in the “Visual tools” toolbar.

If you have activated codes, you will be asked if you want to only visualize those codes in the Document Portrait. Click No if you want all codes to be included. The visualization window will then appear.
The colored squares represent coded segments in the document. You can now see which codes are used in the document and get an idea of the proportions between the various codes. The white spaces represent text segments that are uncoded. If you click on a colored section of the visualization, the corresponding text segment will be highlighted and displayed in the “Document Browser.”

The toolbar for this visualization offers some functions that are not present in the other visualization toolbars:

- Export – saves the visualization as a graphics file.
- Visualize whole document or coded text – allows you to switch between displaying the uncoded segments as white and leaving them out completely. This can be especially helpful if there are large portions of uncoded text.
- Mixed colors for overlapping codes (yes/no) – decides how segments should be visualized that are coded with more than one code. If the above option is off, each of the colors of the codes used to code the same segment will be listed sequentially, one after the other, similar to how it works in the “Overview of retrieved segments.” If the option is turned on, the colors of each assigned code are mixed together.
- Display nodes as circles (on/off) – lets you switch the symbols in the visualization back and forth between squares and circles.

### 12.4 Codeline

Similar to the Document Portrait, the Codeline is a visualization of a single document. It generates a matrix made up of the text paragraphs and the codes used in those paragraphs. The colors in this case only serve an aesthetic purpose, so it is not necessary that you have made meaningful color associations before using this tool.

The Codeline is called up …

- by selecting **Codeline** from the **Visual tools** drop-down menu,
- by right-clicking on a document and choosing **Codeline** from the context menu that appears, or
- by clicking on the appropriate symbol in the “Visual tools” toolbar.
You will then see a dialogue box with the option to only include activated codes (if you have any codes activated) and to aggregate subcodes on the first level. The second option is helpful if you have many subcodes, but want the level-1 code to represent all its subcodes in the visualization.

**Options for creating a Codeline**

After clicking OK, the Codeline visualization window will appear:

![Codeline Visualization](image)

**Codeline: codes in chronological order**

In the example above, you can see the code names on the y-axis and the paragraph numbers on the x-axis. We can tell that the code “Key Quotes” was used in paragraphs 25 and 32, and “Day-to-Day Issues ‘Emotions” was used in paragraphs 26-27 and 29.

To scroll through the paragraphs, you can use the scrollbar at the top of the window:

![Scrollbar](image)

When you use this scroll bar, the list of codes on the y-axis remains visible, so you don’t lose sight of which rows represent which codes.

**Icon functions:**

- This button takes a picture of the visualization as it is currently seen in the window and saves it as a BMP file.
- This button refreshes the graphic, which is helpful if you have changed coded segments since opening it. This saves you the time of closing and reopening the visualization.

### 12.5 Document Comparison Chart

This visualization allows you to compare the codes used in each document. You can call up the Document Comparison Chart:

- by selecting **Document Comparison Chart** from the **Visual tools** drop-down menu, or
by clicking on the icon in the “Visual tools” toolbar.

If you have codes or documents activated, you will be asked if you only want to use these codes and documents. To include all documents and codes, click No. The chart will now appear:

*Document Comparison Chart: comparing codings of texts segments*

The documents from your “Document System” are displayed on the y-axis, and the paragraph numbers are on the x-axis. The colors correspond to the assigned color in the “Code System.” In the above example, orange represents the code “Work Issues,” violet represents “Day-to-Day Issues,” etc. You can see then that in the document “Jonna,” the paragraphs four to eight each included at least one instance of the code “Work Issues,” with at least one instance of the code “Day-to-Day Issues” in the eighth paragraph.

Double-clicking on a section of the visualization opens the associated document in the “Document Browser” and highlights the appropriate paragraph. The scrollbar at the top of the window is helpful for moving through the paragraphs without losing the y-axis labels. You also have the screenshot and refresh icons in the toolbar.

**Tip:** This visualization is especially helpful if you are comparing structured interviews.
The Idea Behind the Summary Grid

The systematic analysis of texts or other information is often about analyzing the data systematically within a structural framework, summarizing it and then grouping it in different categories.

The idea is to look for theoretical explanations for certain phenomena as well as for similarities and differences between texts. In this process, it is important to focus on what the research participants precisely said. But on the other hand, the researcher should also detach from the participants own words. The aim is to sum up and express what was said abstractly, and to eventually present it in a way that is understandable for the recipient. During this analytical procedure, the “raw data,” that is for example interview transcripts, records, field notes etc., should be accessible at all times.

The Summary Grid function of MAXQDA distinguishes two work stages and offers two individual working environments for these stages:

First, the Create and Edit summaries phase, then second, the creation of the Grid Tables, based on the summaries. These two features are accessible from MAXQDA’s main menu under Summaries.

Create summaries and call up Grid Tables

Two options are available from this menu:

- Create and edit summaries
- Grid Tables

A prerequisite for the creation of summaries is that the evaluated texts are already thematically structured, e.g. through an structured interview and automatic code assignments; or texts already coded with a categorical system. A text*/code structure is therefore already in place, that can be represented, for example, using the Code Matrix Browser.

You can picture the summary level as a thematic grid, i.e. a matrix documents * categories (codes). MAXQDA has a matrix like this called the Code Matrix Browser. It displays the texts in the columns and the categories in the rows.

The Summary Grid is a second analytical level that contains the summaries written by the user for every node of the CMB. The user writes individual summaries and can edit them later, e.g. by adding or altering the information. The idea is to present the summaries in overview tables at a later stage of the analysis. This grid allows every summary to stay linked to the original text segment from the raw data.

Creating and Editing Summaries

To create and edit summaries:

- from the menu, select Summaries > Create and edit summaries
- or click on the Create and edit summaries button.

MAXQDA will then open a new window called “Summary Grid.” The window is divided into three areas:

- Left window: the thematic grid, the Code Matrix Browser display
Middle window: the coded segments, so exactly what is normally listed in the “Retrieved Segments” window after right-clicking a node in the Code Matrix Browser.

Right window: the summary, this is where the summary is displayed, created and edited.

Window “Summary Grid”

The content of the columns and rows displayed in thematic grid in the left-hand column can be limited using these buttons:

- Only activated Documents - Only documents which are activated in the “Document System” will be displayed (as columns).
- Only activated Codes - Only codes which are activated in the “Code System” will be displayed (as rows).

In the right window, you can write and edit a summary for the node you have selected in the left window. You can select a node by clicking on it. The summary will automatically be saved after selecting a different node or closing the window.

Tip: You can move text segments from the middle window “Coded segments” to the right window via Drag and Drop. This way you can easily insert citations in the summary.

13.3 Grid Tables

A Grid Table is an overview table of summaries and document variables for selected documents and codes. It gives you an overview of the summaries for selected topics. Grid Tables are a useful tool for presentations and publications.

To create or view Grid Tables,

- select the menu item Summaries > Grid Tables
- or click on the Grid Tables button.

The “Grid Table” window will open, which is constructed similarly to the MAXMaps window.

On the left side you find a list of the Grid Tables you have already created and in the window on the right you can view the Grid Table that is currently opened.
To create a new Grid Table, click the Grid Table button. A dialog window will appear, in which you can choose the documents, variables and codes to appear in the Grid Table.

Select codes for a new Grid Table

When you click OK, the Grid Table with the selected options will be created:

The Grid Table lists all summaries for the selected codes.

In the first column of the Grid Table, you can see the document group and document name. In addition, the variable values of the variables chosen are displayed underneath each document. This enables you to receive further information about a certain case in the Grid Table.

All table functions of MAXQDA are available:

- Change the order of the columns using Drag & Drop.
Hide or show columns (right-click on the column header and choose Select fields).

Sort a column alphabetically by clicking on a column header.

The table is in plain text format, so the entire table is formatted with the same font.

**Note:** You can edit any cell of the Grid Table individually, that means you can modify the summaries displayed. Changes in the content of the Grid Table will also affect the summaries. This means that the content of the corresponding cell in the Summary Grid also changes accordingly.

Each cell of the Grid Table is connected invisibly to the assigned coded segments. These can be viewed in the window “Retrieved Segments” by right-clicking in the cell of the Grid Table and choosing “Display associated coded segments.”

**Note:** The Grid Table is dynamically linked to MAXQDA data. As soon as you open a Grid Table, it scans your project for deleted documents, codes or variables, so that they can be removed or updated if necessary.
14 Mixed Methods Functions

MAXQDA offers a number of mixed methods functions, allowing for the combination of qualitative and quantitative data. They can be found in the Mixed Methods drop-down menu.

The functions have the following specific meanings:

1. **Activate by document variables** – lets you activate documents to be included in retrieval based on document variable values. You could, for example, use this function to identify what men between the ages of 40 and 50 said about migration issues.

2. **Quote Matrix** – creates a Word file showing what different groups said about a theme based on certain variable values that you specify. Each group’s coded segments for the specified codes are in a different column. You could, for example, choose to see how those with various levels of education differ on their approach to combating homelessness.

3. **Crosstabs** – works parallel to the Code Matrix Browser, except that this function doesn’t work on the document level. Instead, you can create groups based on your variable values and compare how often each of these groups talks about each theme. You could, for example, compare how often men talk about relationships in your life satisfaction interviews in comparison to women.

4. **Typology Table** – shows an overview of variable values for qualitative typologies that you have created (e.g. for people with various views on combating their own homelessness). You could see, for example, what the mean age, gender breakdown, and average time already homeless is for the “apathetic pessimists” in comparison to the “proactive optimists.” **Configuration Table** - This table shows which combination of codes exist in selected documents.

5. **Statistic of subcodes** – MAXQDA’s statistics and graphics module lets you create frequency tables and charts for subcode frequencies.

14.1 Activate by document variables

In addition to manual activation, there are also automatic activation options. With the **Activate by document variable** function, you can choose to activate documents based on the variable values that have been assigned to them. If you have defined variables for gender, age, and education level, for example, you could choose to select only those documents that represent women over the age of 40 that have at least a high school education. These activations can be made by entering the appropriate formulas. The formula syntax in MAXQDA is similar to that of statistics programs like SPSS.

The “Activate by document variables” function always processes the entire project. You can access the function by choosing **Activation by document variables** from the Mixed Methods drop-down menu or by right-clicking on the Documents icon in the “Document System” and choosing **Activate by document variables** from the context menu that appears.

All logical formulas must have the following components:

```
variable name / operator / value
```
If you have created a variable called “Gender” and used the characters “Male” for male and “Female” for female, we would use the following formula in order to activate those documents or document sections that have been assigned to women:

\[ \text{Gender} = \text{Female} \]

Entering logical formulas for your activations can be done in the window shown below. Additional details can be found in the manual.

**Dialog field for activation by variable**

### 14.2 Crosstabs

The Crosstabs function has some similarities to the Code Matrix Browser, except that documents are analyzed grouped by document variable. Social groups, such as men and women, or people with different personal background, etc. can be compared based on variable values. All of the variables that are in your project can be used to set up a group.

The first step is to activate codes in the Code System. If no codes are activated, the **Crosstabs** option in the **Mixed Methods** drop-down menu will be grayed out.

After activating codes and clicking on **Crosstabs**, a window will appear where you can enter formulas for the various columns.

First, click on the **New** button to create the first formula. A screen will appear with all of the variables in the project, which you can use to create the formulas.
Selection of variables

You can see in the screenshot above that the variable “Gender” has been selected. You would then click on OK to go back to the formulas screen.

You can then set the formula for which gender is to be represented in each column:

Different values of a variable can be added

Simply click on OK to create the Crosstabs.
Crosstabs comparing the number of coded segments for each code by women and men

The codes are listed on the y-axis, and the specified variable values are listed on the x-axis at the top of each column. Each cell shows how often each code was found in documents where Gender=Female (column 1) and where Gender=Male (column 2).

The following options are found in the toolbar at the top of the window:

- Shows the Crosstabs matrix in Excel.
- Exports the Crosstabs matrix in either XLS/X or TXT (tab delimited) format.
- Saves a snapshot of the window as it is currently seen in BMP format for later use in a presentation.
- Opens a Quote Matrix for the selected codes and groups in the Crosstabs window.
- Changes the unit of analysis for numerical calculations. You can choose to only display if a document contains the code or not, rather than the total number of segments coded with that code.

These three symbols set how values are shown in the matrix cells. When the icon on the left is selected, the absolute number of coded segments will be included in the output. The middle icon displays the row percentages, the right icon the column percentages.

The “Row percentage” view

Example: 60% of all coded segments about “Emotions” were from documents representing female interviewees.
The “Column percentage” view

Example: 7.9% of all coded segments in the documents representing male interviewees were coded with the code “Emotions.”

14.3 The Quote Matrix

The Quote Matrix is based on the same idea as the Crosstabs function, i.e. to create a joint display of themes and quantitative variables. The Quote Matrix does this on a more detailed, non-aggregated level. Here the coded segments themselves are listed in the cells of the matrix, not only the number of coded segments for that particular cell.

In theory, it would be possible for you to create a Quote Matrix on your own by doing retrievals in MAXQDA for each group and copying them from the “Retrieved Segments” window into a table in Word, but this would take a lot of time.

The results of your Quote Matrix are opened automatically in whatever program is set to open RTF files (e.g. Microsoft Word). The coded segments retain the formatting that they had in MAXQDA. If some of your documents are formatted differently than others, this could lead to a chaotic-looking document. It is recommended in these cases, that you highlight the whole table and assign the same font and size to it.

In order to ensure that the Quote Matrix is readable, it is limited to a maximum of four columns. If you absolutely have to have more columns than that, you can create two different ones and bring them together in your word processor. The Quote Matrix assumes that you are working with categorical variables. If you want to display metric variables, you need to use the Typology Table.

14.4 Typology Table

This function offers yet another way to combine quantitative data and your codes or categorical variables. It is called a Typology Table, because it is able to calculate various variables and their percentages (means, standard deviations, etc.) for qualitative typologies.

The table is set up similarly to the following example from Creswell and Plano’s book “Designing and Conducting Mixed Methods Research” (2010: 292):
Example of a Typology Table

Here, the rows contain different variables divided into two sections: “Sociodemographic characteristics” and “Psychological status.” The table starts with age, which is obviously a metric variable. The next row lists the number and the percentage of women, a category in the categorical variable “sex.” The third row gives a number and also the percentage for the African Americans, also a category of a categorical variable. The next row also gives information about a categorical variable “education less than high school.” The next three rows after the heading “Psychological status” all deal with metric variables. Let’s go into more detail:

The first column of the table “characteristics” contains the name of the variable. The second column “Physician rated patient depressed n=27” gives aggregated information for 27 patients: on average, they are 73 years old with a standard deviation of 5.3 years. Twenty-one of the 27 persons are female, which is equal to 79%.

The third column “Physician rated patient not depressed n=21” gives aggregated information for another group of patients. With an average age of 77.1, they are older than the first group. The standard deviation (5.3 years) is exactly the same as the other group. Fifteen of them are female (71%), slightly less than in the first group. The fourth column gives a probability for a significant difference based on the comparison of group data.
15 Teamwork

15.1 Styles of teamwork

MAXQDA offers three different options for working in a team:

- All team members work on the same project file alternately.
- All team members work with the same text material and exchange their coded segments, memos, and variables.
- All team members work with different texts and later merge their partial projects to one single project.

15.2 Alternately working on the same project

The first option is very easy to do. If your team works on the same computer on different days, it is possible for every team member to simply sign in with their own user name in MAXQDA and open the aforementioned project file (see Chapter 1 First steps in MAXQDA). All program objects (documents, codes, memos, and coded segments) receive a “stamp” (username), which gives information about who created which code/coded segment/memo and when.

You can also send your project file via E-mail to another team member. Just make sure that you do not work on that file on your computer in the meantime, and wait until the other team member sends his worked-on file back. To open a project you have received and saved on your computer, simply click Open other projects in the startup window of MAXQDA and search for the project file that has been sent to you.

15.3 Exchanging and comparing coded segments, memos, and variables

Coded segments, memos, and variables, which have been created by different team members, can be merged with the help of the Export teamwork or Import teamwork functions. These functions can also be used to compare coded segments. It is necessary, however, that the body of data remains identical; the team members exchange memos, coded segments, and variables, but the texts remain unedited. This is how it works:

Teamwork Export

You can export all coded segments, memos, and variables of a text, an entire document group, or all documents by right-clicking on the desired document group or document in the “Document System” and choosing Export teamwork from the context menu. MAXQDA exports all the information to a file which can then be saved to a chosen spot. Teamwork exchange files have the extension MEX. This export file can now be transferred to others in the team (by E-mail, for example).

Choosing to export the information for the document “Milly”
Teamwork Import

It is recommended that you always create a project backup before importing teamwork, since this action cannot be undone!

To insert a colleague’s teamwork, right-click on the matching document or document group and choose **Import teamwork** from the context menu.

You have the option of selecting only particular elements out of the teamwork export file. You can choose which exported text elements should be integrated into which target texts (this may be important in case you have identically named texts in your project file). You can also select the elements to be imported: variables, coded segments, external links and/or memos. The default setting imports all elements. In order to be in control of the import procedures, it is recommended that you create a protocol file. This keeps track of which document has been imported with which coded segments, memos, and variables. Coded segments will be listed with codes and subcodes, as well as paragraphs.

Options for importing teamwork

15.4 Merging of projects

Merge your project with a second project by choosing **Project > Merge projects** from the main menu bar. A dialog window pops up asking which project should be imported. This procedure adds all not yet available memos, coded segments, codes, texts, and variables of the imported project to your project.

Identical texts existing in both projects will be doubled during the merge procedure. If you want to avoid this, use the style of teamwork mentioned beforehand or delete doubled documents by hand!
16 Audio/Visual files

MAXQDA 11 allows you to code audio and video files directly without having to provide a transcript. You can, of course, create transcripts of media files or import previously existing media files and their transcripts into MAXQDA.

You can open any media file for which the correspondent codec is installed on your computer. After selecting the file, the “Document Browser” window will automatically be set to edit mode, so you can transcribe the text to the clip.

**Hint:** If you are having problems with playback of a certain file type, check out the Frequently Asked Questions on the MAXQDA website.

MAXQDA offers the following possibilities for working in synchronization with transcripts and audio or video files:

- You can play your audio with MAXQDA while transcribing text directly.
- You can import a transcript in DOC/X RTF format, assign this document to an audio or video file, then insert timestamps into the transcript. Click on the timestamp to begin playing the media file at the appropriate point.
- You can create transcripts using professional transcription software programs for Windows or Mac and import them into MAXQDA as RTF data. Timestamps created in the original software will be automatically imported and can be used in MAXQDA. You can download the software at [http://www.audiotranskription.de](http://www.audiotranskription.de). This website also provides a wealth of useful information on digital recording and transcription.

16.1 Inserting Audio and Video Files

To make audio and video files available for use in MAXQDA, you can either select Import document(s) in the Documents drop-down menu, or click on the button Import Document(s) in the “Document System.”

**Tip:** You can also easily insert audio and video files from Windows Explorer into the “Document System” via Drag & Drop.

This creates a new document named like the media file; this document is linked to the media file.

**Note:** When inserting a new file, MAXQDA shows a standard set of the most common audio and video files (MP3, WAV, WMA, MP4, MPG, AVI, FLV, WMV).

You can, however, assign any media file to a document if the correspondent codec is installed on your computer. If the codec is installed, Windows Media Player will be able to read the file. For further information, please follow this link.

You can also assign a media file subsequently to an existing document. To do so, right-click on the document in the “Document System” and select Properties. Here, you can insert or change a link to a media file.
Playing Audio and Video Files in MAXQDA

To play a media file in MAXQDA, double-click on the document containing the media file in the “Document System.” This turns on the media player and loads the file for playback. If the “Media player” toolbar is not already visible, it will open after double-clicking. If you want to play a video, the Multimedia Browser window will appear. Now click on the icon Play/Pause on the “Media player” toolbar or press the F4 key.

16.2 The “Media player” Toolbar

To transcribe or code an audio or video file with MAXQDA, you need to work with the “Media player” toolbar. This toolbar offers various functions such as playing media files. In order to work with it, you should become familiar with this toolbar and understand how it works.

To open this toolbar, go to the toolbars drop-down menu and select Media player.

The symbols in the toolbar give you access to the following functions (from left to right):

- **Media Player: switch on/off** – turns on the media player and loads the media file into the Multimedia Browser. You can compare this to turning on a CD player and inserting a CD.

- **List timestamps** – opens/closes the timestamp table of the current file.

- **Sync mode** – turns on/off sync mode, which causes the text to follow the media file, comparable to a teleprompter.

- **Multimedia Browser** – turns on the Multimedia Browser, where you can play videos and code media files.

- **Control Panel** – opens the Control Panel, where you can adjust the playback options for audio and video files.

- **New timestamp F8** – inserts a timestamp in a transcript or a media file.

- **Prev F3** – rewinds the media file to the previous timestamp.
Stop – stops playback and jumps back to the beginning of the file.

Play/Pause F4 – pauses playback at the current position and resumes playback at that same position. You can set a rewind interval to resume playback from an earlier position.

Next F5 – fast forwards the media file to the next timestamp.

On the right next to these icons, you see the time elapsed and total time of the media file. You can jump easily to a certain position using the slider on the right.

16.3 Transcribing Multimedia Files in MAXQDA

Using the Multimedia Browser you can easily play and code audio and video files. To open the Multimedia Browser, there are various options:

1. Click the icon Multimedia Browser on the “Media player” toolbar. To do this, the Media Player has to be turned on by clicking the icon (you can only do this when a document with a media file assigned to it is displayed in the “Document Browser”).

2. Double-click on a document with a video file assigned to it. These documents are marked with the symbol . This opens the document as well as the video file in the Multimedia Browser. If the “Media player” toolbar is not visible already, it will open up automatically.

3. Select Open document and audio file in the context menu of a document that has an audio file assigned to it. If the “Media player” toolbar is not visible already, it will open now.

Opening audio files using the context menu in the “Document System”

The following screenshot shows the structure of the Multimedia Browser:
For video files, the Multimedia Browser consists of six panels:

1. The upper panel shows the video.
2. Underneath, there is a toolbar containing the functions to adjust the view and playback and the functions for coding. Here, you can also see the current playback position and the total time of the media file.
3. Beneath the toolbar, preview pictures are shown.
4. Underneath, you can see the waveform of sound of the media file, and below this, there is a time line where you can see the current playback position precise to the second.
5. Under the time line there is a bar for the timestamps.
6. At the very bottom is an area where the coded segments are visualized by bars.

For audio files, the video window and preview pictures are not shown.

The blue vertical line and the blue bar underneath the time line indicate the current playback position.

The following functions are available on the toolbar:

- **Control Panel** – opens the window with playback options
- **Snapshot** – saves a screenshot of the current video picture
- **New memo** – creates a new memo in the current playback position
New timestamp – inserts a timestamp in the current playback position.

Note: In order to insert a timestamp directly into an audio or video file, the text document associated with this file must contain at least one character because timestamps refer to both the transcript and the media file.

Set clip start – sets the beginning of a clip segment at the current playback position

Set clip end – sets the end of a clip segment at the current playback position

Play clip – plays the segment selected on the waveform

Remove clip – removes current clip marks from the waveform

Go to beginning – jumps back to the beginning

Prev – rewinds the media file to the previous timestamp.

Stop – stops playback and jumps back to the beginning

Play/Pause – starts/pauses playback

Next – fast forwards the media file to the next timestamp.

Go to end – jumps to the end

Slider – helps you jump to a certain position

Info – opens Help

On the far right of the waveform, there are other icons that you can use to adjust the zoom for the waveform and for the preview pictures of videos. The icons are hidden in order to not cover the waveform. They appear as soon as you move the cursor over this area.

Coding in the Multimedia Browser

You can code audio and video files in the same way as texts in MAXQDA. You start by marking a segment of the waveform (a so called “clip”). Typically, you will want to set the beginning and end of a segment in a media file precisely to the split second as the scene and content can change completely from one moment to the other. For this reason, MAXQDA offers a number of functions that allow you to mark an audio or video clip:

1. To roughly mark a segment, keep the left mouse button pressed and select the segment by dragging the cursor over the waveform. The time limits are displayed underneath the beginning and end marks.

2. You can easily alter the time limits of the clip by moving the whole blue-marked segment or by clicking and dragging the outer borders of the segment in the waveform.

3. To play the marked clip, click the icon Play clip or press the F11 key.
Marking a clip

4. You will usually play a media file and then pause exactly at a position where you want to set a new coding. To do this, use the button Play/Pause or the F4 key.

5. When the playhead is at the designated position, click the button Set clip start or press the F9 key.

6. Now resume playback and pause at the position where you want to end the coding. Click the button Set clip end or press the F10 key.

Setting the clip limits at the current playback position

You can now code the selected segments as usual, for example by (a) dragging and dropping the marks on to a code, (b) clicking on an emoticode, or (c) by clicking a color code. Right-clicking on a marked segment opens a context menu that contains three options that are relevant for coding:

When coding is completed, it will be indicated by a horizontal coding stripe in the Multimedia Browser. Below it, on the left, the code name is displayed. The coding will also be indicated by the color of the waveform (green for standard codes, other colors for color codes). If various codes are layered on top of each other, the color of the waveform is a mix of the colors. Coded segments with an emoticode are indicated by the Emoticon next to the coding stripe.

Clicking on a coding stripe selects the coded segment on the waveform. Double-clicking plays the clip.
Importing Transcripts with Timestamps

Visualization of codings in the Multimedia Browser

Right-clicking on a coding stripe opens a context menu with the usual options (Modify weight, Edit comment, Delete)

Coded segments which have a comment are marked with a white square on the left hand side of the code stripe.

Attaching Memos to Audio and Video Clips

You can attach memos for notes to any playback position. To attach a new memo,

1. Right-click a position of the waveform
2. Or click the button New memo in the Multimedia Browser toolbar.

Creating memos

16.4 Importing Transcripts with Timestamps

You can use timestamps – which are visualized similar to the way memos and coding stripes are seen in the “Document Browser” – to synchronize your transcripts with the original audio or video files. These audio and video files can even be played in MAQDA in the integrated media player. A timestamp table also lets you insert comments for each section of your transcript represented by that timestamp, so you can later search for these comments and go directly to that section of the text or audio and video file.

There are three different ways to work with text and audio and video files:

Option A

First you do the text transcription with whatever transcription software you want to use, import the transcription as a document in MAXQDA, and then link the document to the original audio/video file. At this point, there aren’t any
connections between specific segments of the transcript and parts of the external file. These connections have to be created with timestamps within MAXQDA.

Option B

The first step in this variation is to transcribe the file with the professional software f4 (http://www.audiotranskription.de/english/home), in which you can create timestamps as you transcribe. You can then export the transcript in RTF format and import it into MAXQDA, and the timestamps are imported along with the text. You will then already have the connection between your text and the audio or video file.

Option C

In this variation, you transcribe the file within MAXQDA.

The second variation is the most efficient, because you have the advantage of a professional transcription software, and – as opposed to in the first variation – you don’t have to create the timestamps within MAXQDA. The option to transcribe audio and video files directly in MAXQDA doesn’t have as many features as a program that is designed to only do the specific task of transcription. It is, however, possible since MAXQDA 10.

16.5 Importing f4 Transcripts with Timestamps (Option B)

When transcribing with f4, it is recommended that you set up a standard structure of timestamps. The easiest way to do this is to set the program to automatically insert a timestamp every time you hit the Enter/Return key. It is also recommended that you take advantage of the shortcut keys to mark which sections are being spoken by different people (e.g. in group discussions). This is accomplished selecting Insert time stamp at the end of each paragraph in f4.

![f4 option for automatically inserting timestamps](image)

**Important:** MAXQDA can interpret timestamps in a transcript only when they appear at the end of a paragraph.

Furthermore, when transcribing, it is useful to make use of f4 keyboard shortcuts in order to differentiate between speakers, for example in group discussions or interviews.

To import the transcript including timestamps and media files into MAXQDA, follow these steps:

Save the transcript in f4 as a RTF file. Ensure that the option **Save with time stamps** is selected. Timestamps will then remain in the text, marked with a “#” symbol at the beginning and end.

Insert the file into the “Document System” in MAXQDA by selecting **Documents > Import document(s)**, or with the **Import document(s)** button in the “Document System.”

When the file is imported, MAXQDA automatically recognizes that it contains timestamps and prompts you to select the appropriate media file. Choose the appropriate file from the dialog window and confirm your selection by clicking **OK**.
When the file is imported, MAXQDA formats and inserts timestamps into the timestamps table, removing them from the text for improved readability.

**Important Note 1:** MAXQDA allows only one timestamp per paragraph. If a paragraph contains several timestamps, new paragraphs will automatically be created.

**Important Note 2:** The timestamps are only imported when a media file is selected. Subsequent automatic linking of transcripts with media is not possible!

Open the imported document by double-clicking it in the “Document System.”

**Note:** Documents with associated media files are marked with special symbols: 📧 for audio files and 📀 for video files.

When imported, timestamps from text, audio and video files will appear in the corresponding column before the text in the “Document Browser.”

The audio or video file will not be loaded automatically when you open MAXQDA, but only when it is activated in the “Media player” toolbar – the “Media player” toolbar must therefore be displayed first (via the Toolbars drop-down menu). To load the media file click on the Media Player: switch on/off button.

**16.6 Transcribing Directly in MAXQDA (Option C)**

It is also possibly to transcribe audio and video files directly in MAXQDA. To do so:

Right-click on a document group or the Documents icon in the “Document System” and select Transcribe audio/video from the context menu that appears.

You will then see a dialog field, in which you can select the file to be transcribed.

MAXQDA automatically creates an empty document named like the media file, connects it with the media file and opens it in the Edit mode in the “Document Browser.” You can now play this file in MAXQDA’s media player and start the transcription in the empty document. The waveform of the media file will be opened in the Multimedia Browser so that you can navigate easily.

---

*Empty transcript and waveform in the Multimedia Browser*
From this point on, you can play data on MAXQDA’s built-in Media player, and begin the transcription process. You can process media files and insert timestamps using the icons in the Multimedia Browser and “Media player” toolbar as well as various keyboard shortcuts.

You can also access further transcription options via the Control Panel icon in the “Media player” toolbar.

**Set options for playing media files and transcribing**

- **Volume** – set volume from 0 to 100 percent.
- **Playing Speed** – allows adjustment of playing speed from half to one-and-a-half times.
- **Rewind Interval** – Sets number of seconds to rewind from 0 to 10 when you start playing a media file.
- **Timestamp on enter** – If this option is selected, a timestamp will automatically appear in the “Document Browser” each time you press the Enter key.

In order to facilitate the transcription process, MAXQDA 11 offers improved foot pedal functionality for foot pedals:

Previous versions of MAXQDA supported only the yellow “Science” switch, whose function is the same as the F4 key: Press once to play, and a second time to stop.

In MAXQDA 11 (and in MAXQDA 10 from Release 111111) the black “Science II” switch is also supported. This switch can be held down to play media data, and will stop playing when released.

### 16.7 Synchronizing Transcribed Text with Audio/Video files

MAXQDA allows you to play an audio or video file at the same time as the transcript. You can view media files synchronized to their transcribed texts, like a teleprompter for a television presenter, or karaoke, in which you can read the text on the screen while listening to the music.

To start a synchronized playback, click on the **Sync mode** button in the “Media player” toolbar.

Begin by clicking the **Play** button or the **F4** key. You can also click on a timestamp in the document.
16.8 The List of Timestamps

The timestamps list has as many rows as there are timestamps in the document, and every row has three columns. The first two columns contain the start and end points of that segment. In the third column, you have the option of writing in a short comment about that particular segment.

The list of timestamps

These columns are set up just like columns in any other MAXQDA table. Clicking on any of the column headers sorts the table by that particular column alphabetically (another click changes it to reverse alphabetical order). You also have the option to search in a column by right-clicking on the column header and selecting Search. If you don’t know if your search term is the first word in the column, you can insert a “*” before your term. (A search for “*any” would find the word “company,” for example.)

If you are importing a document with timestamps, you still have the option to add new ones once it has been imported into MAXQDA. The option to write your comments in the list of timestamps also gives you a new way to find sections of your media file. Double-clicking on a row takes you to that section of the text in the “Document Browser” and starts playback of the media file from that point.
MAXMaps offers a new perspective on your data and the connections within it. The primary task of MAXMaps is to provide a graphical representation of the different elements within a MAXQDA project. These “objects” can be inserted into the MAXMaps drawing pads, and connections can be made in order to visualize a complex graph of relationships. MAXMaps also allows you to design graphical models or networks that are completely independent of MAXQDA’s data. That’s why MAXMaps is a universal graphics software tool that is not only restricted to applications in qualitative research within the social sciences. All elements of MAXQDA, e.g. codes, memos, coded segments, and documents, may be imported into a map. In addition, MAXMaps also allows you to insert so-called free elements (text, pictures, and graphics) that can be chosen by the user.

MAXMaps can be used for different purposes. Maps can help to explore and organize data. They allow you to develop your ideas and to communicate them to others. Maps can also be a valuable tool for scientific explanation and can help to visualize complex relationships and theories. For instance, you can create tables and worksheets to gain a better perspective of the different elements within a project. MAXMaps can also be used for presentations and lectures. The different layers of a map may be displayed in arbitrary order; thus, a variety of different options for designing presentations are available.

With MAXMaps, it is possible to display:

- The relationships between different codes and categories.
- An overview of different facts and phenomena within the research field.
- The different memos belonging to a document or a group of documents.
- The context or important facts of the research, e.g. photographs of locations or persons.
- A graphical overview of the research methods used.
- A research timeline.
- The research design and characteristics of the sample.

MAXMaps can also have different functions for researchers. You can, for instance, use MAXMaps to organize and manage your “Code System.” Or you can link codes, text, and memos in a hypothetical order to then further test the relationships in a second step.

MAXMaps is not merely a graphics tool that works with icons and symbols, though. All the elements used in a map are interactive, meaning they are connected to the MAXQDA project. Simply switch to “sync mode” to establish a connection to the MAXQDA database. This makes an icon that symbolizes a text document not only a passive icon, but allows you to double-click on the icon to open the document in MAXQDA’s “Document Browser.” Then you can read and browse through the document. The same is true for memos. As soon as you click on the memo symbol, the memo appears and can be read or even modified. In the case of symbols for coded segments, one click displays the segment, which allows you to examine and compare different segments of your map.

MAXMaps allows you to define connections and relationships as you choose. These connections may be hypothetical -- they do not even have to be consistent in logic while you are designing the maps because you are always free to make changes. As a result, you can “play” with different models and relationships. For example, a code “attitude” may appear as a condition of another code “behavior” in Map A and as the result of the code “behavior” in Map B. Constructing, testing, and modifying different models is an important aspect of analysis, thus making it counter-productive to be consistent with links and relationships right from the beginning.

MAXMaps not only allows you to define links and relationships, it also offers a way to make links and relationships that have already been implemented in your project visible. Examples are memos that have been assigned to a document: MAXMaps can import all the memos that are connected to a document automatically. These memos are displayed as symbols and you can open and read them. The same is true for codes: If you have imported a code in your
map, all the memos linked to this particular code can also be imported automatically. Moreover, you can search and insert all of the codes overlapping with a code on your map and automatically connect them to the code.

These features do not establish new links or new relationships, but they allow for completely new perspectives to your data. Connections that have likely been hidden in listings or tables can now surface. New views and relationships become visually apparent and much easier to understand. The connections between different elements of the diagram are not restricted to hierarchical relationships as with the “Code System” in MAXQDA. In MAXMaps, relationships can be represented in a more complex way, for instance as networks or any other type of model.

This visual method of data display is supported by the variety and flexibility that characterizes MAXMaps. All elements used in a map may be designed individually. Codes, memos, and texts are not always displayed with the same symbols and colors. You can select different symbols, colors, fonts, and sizes, or even import your own symbols unique to each element of your map. All labels, images, and symbols can be managed individually. You can also import your own photographs, icons, or clip art.

An introduction to MAXMaps and an overview of all of its functions can be accessed by opening MAXMaps and then clicking on the blue symbol in the toolbar.

A map displays the relations between codes
18 Special Functions

18.1 Logbook

The Logbook makes it possible to keep a research journal in which you can write down each step of your data. The logbook can be called up from the Memos option on the main menu:

Calling up the Logbook from the main menu

At the top of the window is a toolbar that allows quick access to the various functions:

Logbook Toolbar

To add a new entry to the logbook, click the New logbook entry button. A new header with the time, date and user name will be created. New entries will always appear at the top of the logbook. You can also use the Windows clipboard to copy or paste text from the logbook.

18.2 User Management

MAXQDA allows the (optional) creation of an Admin System with specific user rights for specific user groups. In this way, the security of individual projects is assured. The user who activates User Management is automatically assigned the role of Administrator. Aside from the Admin-Level, three distinct groups, Level 1 to Level 3, can be defined. For example, in a research project, levels could be defined as follows:

- Administrator Level
- Level 1: Project leaders
- Level 2: Research associates, who can import or delete texts, work with the Code System, and write, edit or delete memos
- Level 3: Student assistants, who work primarily on coding the material

The following figure shows the default functions for Level 1 users. The top three are reserved for the Administrator level. User rights can be modified at any time by clicking on the green symbol in front of the program function. Any number of users can be assigned to each group.
MAXApp is an app for mobile devices that use the iOS operating system. The app supports projects containing text documents, images, videos and sounds. The app is particularly useful for researchers who collect field data in various formats, e.g. videos, audio clips or photos. Observations in the form of texts and memos can also be included.

Each document can be coded with emoticode. Within text documents, text segments can be coded exactly as in MAXQDA using emoticons and symbols. Memos can be assigned to projects and individual documents. The projects can be exported via Dropbox, then imported into MAXQDA.

The following figure shows the Project List in the left window and the list of corresponding documents in the right window on an iPad and a list of documents on an iPhone:
18.4 Intercoder Agreement

With the “Intercoder Agreement” function, it is possible to compare how segments were coded by two independent users. In qualitative analysis, one aims for maximum reliability of code assignments. Compared to the usual measurements of reliability in the quantitative research; the principal concern is a practical improvement of the quality of the encoding rather than determining a coefficient which gauges quality in a static sense. The objective is therefore to eliminate the inconsistencies and non-compliance of coded segments in order to work with “better” encoded material.

The starting point is for two (or more) independent users to code the same document, after which the coded segments of all users are verified. The Intercoder Agreement function, accessed from the Analysis menu, examines the compliance of each user in the assignment of codes, and identifying where they do not match.

The Intercoder Agreement function includes three options regarding analysis criteria:

- **Option 1 – Level of Comparison: Document**
  - The criterion is the presence or absence of codes in a document. This option is useful, above all, when working with relatively short documents and many codes.

- **Option 2 – Level of Comparison: Document**
  - The criterion is the frequency of codes in a document, or, more precisely, the compliance of the frequency of the assignment of the code.

- **Option 3 – Level of Comparison: Segment**
  - This option verifies whether the encoding of 2 users for the same segment match. This option is the most far-reaching, and the most typical for qualitative coding. It is possible to set a percentage value, which is the minimum overlapping needed for two coded segments to be defined as “matching.”
Overview tables compare the use of codes in the documents. The code-specific results table displayed below details the matches by code.

![Code-specific results table]

**18.5 Importing from Endnote, Citavi etc. (RIS-Format)**

MAXQDA 11 allows you to import bibliographical data from reference management software such as Endnote, Citavi and Zotero. These programs are used mainly in the scientific fields to manage references and create bibliographies in the objective of supporting the creation of scientific texts. Reference management programs are similar to MAXQDA in that they work with projects and contain collected bibliographical information. The units of the project include Title, Author, etc., and may also include links to websites and related information.

MAXQDA is compatible with all reference management programs which can export their reference databases in RIS format, a standard format for bibliographical data. The RIS data contains two-letter “tags,” which are followed by the relevant information.

After import and automatic pre-coding, a normal text view of the bibliographical data is available in MAXQDA. This means that the data can be searched, coded, linked, and edited, and that memos can be attached. All Visual Tools and other functions (e.g. Statistics and Graphics) can also be employed. Automatic pre-coding makes it is possible to isolate specific document types for analysis, e.g. journal articles only or anthology entries only.

**18.6 Smart Publisher**

The Smart Publisher is a convenient report generator. It exports selected retrieved segments in a formatted Word document report, including title page and table of contents. The structure of the report is determined by the Code System:

- An individual chapter will be created for each top-level code.
- A subchapter will be created for each subcode.
- Coded Segments of each code form the content of each (sub)chapter.

When Smart Publisher is called up, a dialog window will appear in which you can select the codes to be included in the report. When top-level codes are selected, their corresponding subcodes will automatically be included in the report. You can also choose to include coded segments only from activated documents.

The Smart Publisher exports a XML file in the background, which contains all the information on the selected codes and is used for the creation of the report.

The result is a Word document (DOCX format) with a title page, table of contents, a page which lists the documents included in the report, and the main section containing the text segments. If a header/footer was included, it will be displayed on all pages following the title page. If an end page was included, it will be found at the end of the report.
All elements are formatted in Word template (DOT) format. Formatting can be modified or pages added into the report, as desired.
19 MAXDictio (Add-On)

MAXQDA users have repeatedly asked for a tool which would allow them to make an index of the words used in a text, and so have access to an additional explorative aid for the evaluation of the text. As a dictionary and content analysis module, MAXDictio makes it easy to explore the vocabulary used in a text as well as to find out which words can be found in which text passages or texts. MAXDictio also enables users to analyze the differences in the vocabulary of the various texts of one project, e.g. the vocabulary used by your interviewees.

After the installation you will see in the familiar MAXQDA interface that the program has been supplemented by the option MAXDictio next to the ? in the menu bar.

Clicking on MAXDictio opens a drop-down menu and you can select one of the options.

Starting MAXDictio

Besides the vocabulary functions, the MAXDictio module offers a number of techniques which have their origin in the field of classical quantitative content analysis. MAXDictio does not intend to try to compete with software for quantitative content analysis, but rather aims at utilizing these techniques for qualitative data analysis and providing these as an additional set of methods in a manageable form.

MAXDictio provides the following functions:

- Word frequency analyses in the whole text or in marked passages
- Word frequency analyses in text groups or in text sets which have been assembled based on textual criteria
- Free definition of text units (whereby these may overlap)
- Editing of texts and their assignment to text units, which is possible throughout the process
- Exportability of the results of the frequency analysis to Office programs (such as Excel or Word) and to SPSS, also by using the Windows clipboard
- Index of selected words of one or more texts
- Possibility of jumping from an index entry to the text passage in which it is found
- Limitation of the analysis with Go-lists (which contain a list of the words that are to be analyzed) and Stop-lists (which contain a list of those words that are to be excluded from the analysis)
- Selective analysis by predetermined criteria, such as the value of socio-demographic variables, and filtering by numeric data
- Formation of word-based dictionaries
- Transfer of words from the word frequency table into the dictionary (simply by clicking on them)
- Export and import of dictionaries from Office programs (e.g. from Excel)
MAXDictio (Add-On)

- Coding on the basis of word-based dictionaries
- Results of the coder as editable and sortable Excel-like table
- Further processing of the results in SPSS and Excel
- Creation of a validation file for the verification of codes
- Total integration in the functionality of MAXQDA which provides convenient functions such as keyword-in-context or the automatic coding of text passages

The simplest function in MAXDictio determines the vocabulary of all texts of a current project.

This function can be accessed by

- either selecting the option **Word frequencies** in the MAXDictio menu
- or just clicking on the corresponding quick button in the toolbar.

Depending on the size of the project, it may take some time for MAXDictio to work through the material text by text, as each word must be isolated, transferred into a list and counted.

What is a word in MAXDictio? A word is, as explained above, any sequence of letters between two delimiters. Delimiters can be spaces, tabs or punctuation marks. For example, ”work.” as the last word of a sentence would be delimited by a space on its left and by a period on its right. Delimiters can be selected from the menu **MAXDictio > Options**.

Enter the characters to act as delimiters in the field entitled ”Characters to be cut off.” Normally, this means the punctuation signs:

! ’ () . ; ?

The table of results for the word frequency function looks as follows:
The above table contains the following information:

- The number of analyzed documents (top left, here = 16)
- The total number of counted and separated words (i.e. “tokens,” here = 13,699)
- The number of different words in the texts (i.e. “types,” here = 3,172)

The first column enables you to quickly exclude a word, to add it to the “Stop-list.” Double-clicking on it changes its status. Words are initially on the “Go-list.” The depicted symbol is then green. When double-clicked, it changes into a red stop sign.

In the next column are the words, such as they appear in the text. Whether the capitalization of words is displayed or not depends on the selected option (in the Options menu).

The third column contains the word length counted in characters.

The fourth column contains the absolute frequency of each word in the searched texts.

The fifth column contains the ratio of the each word’s frequency to “tokens,” i.e. the total number of counted words in all texts, expressed as a percentage. In our example the word “life” was counted 374 times, which is 2.73 percent of the total of 13,699 words.

You have the following possibilities for handling the table:

An alphabetical list in ascending order is generated by clicking on the column title **Word**.

By clicking on the column header **Word** with the right mouse button, a context menu can be opened which contains, among others, the option **Search**. This option opens a dialog box in which you can type the desired word.

A list of all positions of a word in the text can be created by clicking on the word with the right mouse button and selecting the option **Search results** in the context menu.

By double-clicking on a word it can be added to the active Stop-list.

For each word in the list of word frequencies, an index of the positions in the text where the words are found can be created. Click on the desired word with the right mouse button; then select the function **Search results** from the context menu (see illustration below).

![Context menu in the word frequency table](image)

In the illustration above, the word “life” was selected, which appeared exactly 374 times in the 16 documents. Right-clicking on “Search results” opens a list of all results. Click on a reference in this table to jump directly to the corresponding text segment in the “Document Browser.”

It is possible to limit the lexical analysis to activated documents only, or retrieved segments only, by checking the corresponding checkboxes under **MAXDictio > Options**. If you want to perform a lexical analysis of a specific text, only this text must be activated. To perform a lexical analysis of numerous texts or an entire document group, all relevant texts must be activated. Combined with MAXQDA’s “Activation by variable” functions, lexical scores for specific groups of respondents can be performed.
MAXDictio enables you to set up stop-lists. A “Stop-list” is a collection of “uninteresting” words, such as definite and indefinite articles, conjunctions and numerals. Such words are usually sources of irritation when analyzing a text. For that reason, it is advisable to exclude them from the analysis. MAXDictio allows you to create as many “Stop-lists” as you like, as well as to edit and manage them. Words which are in a stop-list will automatically be excluded from the search results table.

To create a “Stop-list,” you can either call up the option Stop-list in the MAXDictio menu or click on the button in the “MAXDictio” toolbar.

There are two different ways of adding words to a “Stop-list”:

- First, you can enter them manually by clicking on the button New at the top of the “Stop-list” window and then typing in the word
- Second, you can select words from a word frequency list and add them to a “Stop-list” by double-clicking on them. You can thus avoid having to type these words in. It is also possible to transfer several words into a “Stop-list” at once. To do so, mark all desired words. Then click on one of the words with the right mouse button and select the option Add to stop-list.

The words in a stop-list are automatically listed in alphabetical order. This order is pre-set and cannot be modified.

Besides its vocabulary functions, the MAXDictio module has a function enabling coding using word-based dictionaries.

There are two ways of accessing the MAXDictio dictionary-function:

- through the menu MAXDictio and the option Dictionary
- through the button in the “MAXDictio” toolbar

A dictionary consists of categories and a list of search items which are allocated to each category.

A dictionary in MAXDictio can contain any number of categories. Exactly one list of search items belongs to each category. The number of search items is not limited.

To add a new category, click on the button New category in the left window containing the list of all defined categories. Then a new category title can be entered. The title is not restricted to a certain length or form. It can also
consist of several words, such as “old-age pension.” The title of a category can be modified later without this having an effect on the dictionary itself.

Setting up a dictionary

Initially, when clicking on New category, MAXDictio will add a category named “Category #.” Here the character # stands for the sequential number of the category in the existing category system. This means that it always begins with “Category 1.”

To add words belonging to a category, select the required category by clicking on it with the left mouse button. Then click on New search item in the Search items window. Now it is possible to enter a new search item.

Each category and each word belonging to a category can be turned on or off individually for the analysis. The procedure is the same as with the categories. The symbol next to each word indicates its state: green=on, red X=off. Initially, each category (or word) is “on,” as indicated by a small green icon. Double-clicking on the icon it will change into a red X. This indicates that the category (or word) will not be considered in the analysis.

Dictionaries may be saved and different dictionaries may be combined into one dictionary.

The MAXDictio coder automatically codes the texts on the basis of an active dictionary. It is important to understand that the term “coding” in MAXDictio has a different meaning than the usual qualitative coding of text segments in MAXQDA. Normally, coding in MAXDictio means that a text segment is assigned a code or subcode in the “Code System.” The coding process in MAXDictio is no such assignment of codes to text sections, but rather the quantitative analysis of one or more texts on the basis of the categories and search items in a dictionary.

Thus the coding process of the coder corresponds to the approach in quantitative content analysis, in which the actual text is redundant and is substituted by counts of words and categories. To clarify this: in MAXQDA, qualitative coding would mean, when coding the bible, for instance, to select a text section and then assign the code “Apostle > Peter” to it. Then, by later activating this code, the corresponding passage could be found again. When working with the MAXDictio coder, you would define the category “Apostle” with “Peter” as an attributed search item. Each time the coder finds the search item, the frequency of the word and of the category is increased by one.

The result of such an analysis of the material with MAXDictio is a matrix which contains the frequencies of the categories.

The MAXDictio coder offers a variety of options that are described in the extended manual that is installed together with the program.
# 20 Important Keyboard Shortcuts

The following important keyboard shortcuts are available in MAXQDA. You can find the complete list of keyboard shortcuts in the menu > Keyboard shortcuts.

## General

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+A</td>
<td>Highlights the entire text.</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copies the selected text to the Windows clipboard.</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Cuts out the selected text and puts it in the Windows clipboard.</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Pastes the selection from the Windows clipboard.</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Opens the Code Matrix Browser.</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Opens the Code Relations Browser.</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Opens the context search for the current window.</td>
</tr>
</tbody>
</table>

## Document System

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double-click</td>
<td>Opens a document.</td>
</tr>
<tr>
<td>Shift+double-click</td>
<td>Opens a document in a new tab.</td>
</tr>
<tr>
<td>Ctrl+click</td>
<td>Activates or deactivates a document.</td>
</tr>
<tr>
<td>F2</td>
<td>Opens a field for renaming a document.</td>
</tr>
<tr>
<td>Drag &amp; Drop, Shift+UpArrow, Shift+DownArrow</td>
<td>Moves a document or document group to a different place or up and down in the “Document System.”</td>
</tr>
<tr>
<td>Ctrl+Drag &amp; Drop</td>
<td>Creates a copy of the document.</td>
</tr>
<tr>
<td>Ctrl+T</td>
<td>Creates a new document and opens it for editing in the “Document Browser.”</td>
</tr>
<tr>
<td>Ctrl+Shift+T</td>
<td>Opens the dialog window for importing a document at the top of the “Document System.”</td>
</tr>
<tr>
<td>Alt+T</td>
<td>Opens the dialog window for importing a document into the selected document group.</td>
</tr>
</tbody>
</table>

## Code System

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F2</td>
<td>Opens a field for renaming the code.</td>
</tr>
<tr>
<td>Drag &amp; Drop, Alt+UpArrow, Alt+DownArrow</td>
<td>Makes a code into a subcode of another code.</td>
</tr>
<tr>
<td>Ctrl+Click</td>
<td>Activates or deactivates a code.</td>
</tr>
<tr>
<td>Alt+N</td>
<td>Creates a new code on the activated level.</td>
</tr>
</tbody>
</table>

## Document Browser

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Shift+E</td>
<td>Toggles Edit Mode.</td>
</tr>
<tr>
<td>Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Alt+L</td>
<td>Codes the selected segment with the most recently-used code.</td>
</tr>
<tr>
<td>Ctrl+W</td>
<td>Opens the dialog window for creating a new code, which will be used to code the selected segment.</td>
</tr>
<tr>
<td>Ctrl+Q</td>
<td>Codes the selected segment with the code shown in the Quick List.</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Codes the selected segment with a newly-created code named after the first 32 characters of the selected segment (in-vivo coding).</td>
</tr>
</tbody>
</table>